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Quick Start to Maya
Installation

Welcome to Autodesk® Maya® 2011. This chapter gives a brief overview of installing Maya
on all supported platforms. Use this Quick Start guide if you are already familiar with installing
Maya. If you need more detailed information on installing Maya, refer to the Maya Installation
on page 9.

The Maya installer gives you the option of installing Maya® Composite, Autodesk®

MatchMover™ camera tracker, and Autodesk® Backburner™ network render queue manager.
You do not need a separate license to install and run these applications.

NOTE You must install Maya if you want to install and run MatchMover or Composite.
You can install and run Backburner without Maya.

Introduction
The basic workflow to install Maya on a single computer is as follows:

1 Complete the tasks described in Prepare to Install Maya on page 4.

2 Install Maya on your preferred platform:

■ Windows on page 4

■ Mac OS X on page 6

■ Linux on page 7
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NOTE If you will use a network license to run Maya, contact your network
administrator to find your license server name before you start the installation.
You can enter your license server name in the installer to configure your
network license.

3 If you will use a stand-alone license to run Maya, see Register and Activate
Maya on page 27 for information on obtaining your license.

Prepare to Install Maya
Before you install Maya, ensure that you have done the following:

■ See www.autodesk.com/qual-charts to verify system requirements.

■ Locate your serial number and product key.

■ Understand which license type you use (stand-alone or network).

■ Close other programs.

See Preparing for Installation on page 9 for more detailed information.

Quick Start: Install Maya on Windows
To install Maya, you can follow the instructions in the Autodesk Maya
Installation wizard. This section provides a brief overview of the install steps.

If you require more detailed information, see Install Maya on Windows on
page 13.

To install Maya on Windows

1 Do one of the following to open the Maya installer:

■ If you are installing from a DVD, insert the DVD into your drive.
The Autodesk Maya installer appears. If the installer does not start
automatically, double-click the setup.exe file on your DVD drive.

■ If you are installing from a download package, double-click the Maya
executable file that you downloaded.

2 Click Install Products to start the installation, then follow the instructions
in the install wizard to continue.
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3 In the Select the Products to Install window, select the components you
want to install.

This window lets you choose whether to install the Maya 2011
documentation, Autodesk MatchMover, Composite, and Autodesk
Backburner.

4 In the User and Product Information window, enter your name,
Organization, Serial Number and Product Key, then click Next.

5 In the Begin Installation window, do one of the following:

■ To install Maya with a stand-alone license and default installation
options, click Install.
Obtain your stand-alone license later by following the steps in Register
and Activate Maya on page 27.

■ To change any installation options, for example to enter network
license information or to change the default install path, select the
product you want and click Configure.
A window appears with tabs for each component you selected to
install. Each tab gives you a wizard for configuring additional
installation options. Select the tab for any component you want to
change, then follow the instructions to complete the configuration.

NOTE If you select the Network license type, enter your license server
name in the field that appears. Contact your network administrator to
find the name of your license server.

When you are finished, click Configuration Complete to return to
the Begin Installation window and click Install.
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A series of images displays as Maya installs.

6 In the Installation Complete window, click Finish.

By default, Maya is installed in the following directory: C:\Program

Files\Autodesk\Maya2011.

Quick Start: Install Maya on Mac OS X
To install Maya, you can simply follow the instructions in the Autodesk Product
Configuration wizard. This section provides a brief overview of the install
steps.

If you require more detailed information on each window of the installer, see
Install Maya on Mac OS X on page 16.

To install Maya on Mac OS X

1 Do one of the following to open the Maya installer:

■ If you are installing from a DVD, insert the DVD into your drive, then
double-click the Maya DVD icon that appears on your desktop.
Navigate to the Maya/MacOSX folder on the DVD drive.

■ If you are installing from a download package, double-click the Maya
.dmg.

2 In the Finder window that appears, double-click the Install Maya 2011
program.

3 Follow the instructions in the Autodesk Product Configuration wizard
to start the installation.

4 In the Choose components window, select the components you want to
install and click Next.

This window lets you choose whether to install the Maya 2011
documentation, Composite, MatchMover, and Backburner. The
components you select will install automatically with Maya.

5 In the Maya 2011 License Configuration window, do the following:

■ Enter your 11-digit serial number.

■ Enter your Product key.

■ Select your License type: Standalone or Network.
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If you select the Standalone license type, obtain your stand-alone
license later by following the steps in Register and Activate Maya on
page 27.

If you select the Network license type, enter your license server name
in the Server name field that appears. Contact your network
administrator to find the name of your license server.

6 Click Done in the final window.

By default, Maya is installed in the following directory:
/Applications/Autodesk/maya2011.

Quick Start: Install Maya on Linux
To install Maya, you can simply follow the instructions in the Autodesk Product
Configuration wizard. This section provides a brief overview of the install
steps.

If you require more detailed information on each window of the installer, or
for information on installing using the rpm utility, see Install Maya on Linux
on page 17.

To install Maya on Linux

1 Do one of the following to start the Maya install:

■ If you are installing from a DVD, insert the DVD into your drive.
Mount the DVD drive if it does not mount automatically.

■ If you are installing from a download package, extract the Maya
packages from the compressed file.

2 Extract the Maya packages from the compressed file you downloaded.

3 Open a shell as a super user and navigate to the directory where you
extracted the packages.

4 Type ./setup and press Enter.

This starts the Autodesk Product Configuration wizard.

5 Follow the instructions in the install wizard to install Maya.

6 In the Choose components window, select the components you want to
install.
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This window lets you choose whether to install the Maya 2011
documentation, MatchMover, Composite, and Autodesk Backburner.

7 In the Maya 2011 License Configuration window, do the following:

■ Enter your 11-digit serial number.

■ Enter your Product key.

■ Select your License type: Standalone or Network.
If you select the Standalone license type, you can obtain your
stand-alone license later by following the steps in Register and Activate
Maya on page 27.

If you select the Network license type, enter your license server name
in the Server name field that appears. Contact your network
administrator to find the name of your license server.

8 Click Done when the Installing Maya 2011 confirmation window appears.

By default, Maya is installed in the following directory:
/usr/autodesk/maya2011-x64.

See also Additional Linux Notes on page 22.

8 | Chapter 1   Quick Start to Maya Installation



Maya Installation

Stand-Alone Installation
The Maya Installation and Licensing guide provides instructions on how to prepare,
and then install Autodesk Maya. If you have never installed the product before,
you should familiarize yourself with the entire installation process and options
before beginning.

For information about network-licensed versions of the program, see Choose
an installation type on page 31.

Preparing for Installation
To prepare for installation, you should review the system requirements,
understand administrative permission requirements, locate your Maya serial
number and product key, and close all running applications. Complete these
tasks, and you are ready to begin installing Maya.

Refer to the following sections for more information on each installation
prerequisite.

Verify system requirements
The first task you need to complete is to make sure that your computer meets
the minimum system requirements. If your system does not meet these
requirements, problems can occur, both within Maya and at the operating
system level.

To review the requirements, see www.autodesk.com/qual-charts.

2
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Administrative Permission Requirements
To install Maya, you must have administrator permissions. You do not need
to have domain administrative permissions. See your system administrator
for information about administrative permissions.

You do not need administrator permissions to run Maya. You can run the
program as a limited user.

Locating Your Serial Number and Product Key
When you install Maya, you are prompted for your serial number and product
key in the Product and User Information page, or the option of installing the
product in trial mode. You may enter your product information at any time
during your trial mode period if you opt to install the product in that mode.

The serial number and product key are located on the outside of the product
packaging, or in the Autodesk® Upgrade and Licensing Information email.
Make sure to have these available before you install the program so that you
don't have to stop in the middle of the installation.

The serial number must contain a three-digit prefix followed by an eight-digit
number. The product key consists of five characters.

The information you enter is permanently retained with the product. Because
you can't change this information later without uninstalling, take care when
entering the information.
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NOTE If you have lost your serial number or product key, contact the Autodesk
Business Center (ABC) at 800-538-6401 for assistance.

Minimize the Chances of Installation Failure
The Maya installation process may stop if some applications such as Microsoft®

Outlook® or virus-checking programs are running. Close all running
applications to avoid possible installation problems and data loss.

Choose a Language
You can specify both the language in which the installation or deployment
instructions are displayed, and the language of the products being installed
or deployed.

As you begin an installation or create a deployment, the installer detects your
operating system’s language. If the detected language is supported, your
installation or deployment instructions are displayed in that language. You
can change the language for the instructions from the Language drop-down
list on the initial page of the installation wizard.

To change the language of the products being installed or deployed, select
another language on the Select the Products to Install or Select the Products
to Include in the Deployment pages.

The following rules apply to language selection:

■ Only one language can be chosen for each installation session. For example,
you cannot select English for one product, and then select German for
another product during the same installation.

■ Only one language can be chosen during deployment creation. One
administrative image can contain deployments for different languages,
but each deployment must be targeted for one language.

■ If you are editing an existing deployment, or creating a new deployment
using an existing deployment as a template, the Language drop-down list
is unavailable. The existing deployment’s language is used.
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■ If a language is not supported, a default language is used.

Installing and Running the Product
To use the product, you must install the product, register and activate it, and
then launch it. You must have administrative permissions to install Maya.

This section provides instructions for installing and activating Maya for an
individual user on a stand-alone computer. For information about installing
network-licensed or multi-seat stand-alone versions of the program, see
Network Administration and Deployment on page 30 and the Network
Licensing Guide on page 79.

Installing Maya
The Maya Installation wizard contains all installation-related material in one
place. From the installation wizard, you can access user documentation, change
the installer language, select a language for your product, install supplemental
tools, and add online support services.

■ Review the installation documentation. It is recommended that you take
the time to familiarize yourself with the complete installation process
before you install Maya. You can access information on installation from
the installation wizard by selecting the Read this Documentation option, the
Documentation and information links, or through the Help system.

■ For late-breaking information, it is also recommended that you review the
Maya Release Notes available at www.autodesk.com/maya-release-notes.

The Maya installer gives you the option of installing Maya® Composite,
Autodesk® MatchMover™ camera tracker, and Autodesk® Backburner™ network
render queue manager. You do not need a separate license to install and run
these applications.

NOTE You must install Maya if you want to install and run MatchMover or
Composite. You can install and run Backburner without Maya.

Refer to the following sections for instructions on installing Maya on each
platform:

■ Install Maya on Windows on page 13
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■ Install Maya on Mac OS X on page 16

■ Install Maya on Linux on page 17

Install Maya on Windows

Install Maya Using Default Settings on a Stand-Alone Computer

To install Maya using default values on a stand-alone computer

This installs Maya to the default install path of C:\Program
Files\Autodesk\<Maya>.

1 Do one of the following to start the Maya Installation wizard:

■ If you are installing from a DVD, insert the DVD into your drive.
If the installer does not appear automatically, double-click the
setup.exe file on your DVD drive.

■ If you are installing from a download package, double-click the Maya
executable file that you downloaded.

2 On the initial page, select a language for the installation instructions.
Click Install Products.

3 On the Select the Products to Install page, select your product(s) and the
product language. Click Next.

4 Review the Autodesk software license agreement. Click I Accept, and then
click Next.

5 On the User and Product Information page, enter your user information,
serial number, and product key. Click Next.
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WARNING After you click Next, you cannot change the information entered
on this page unless you uninstall the product.

6 On the Begin Installation page, click Install.

7 On the Installation Complete page, note the directory path where you
can find and read the installation log.

8 Click Finish.

You have successfully installed Maya. You are now ready to register your
product and start using the program. To register the product, start Maya and
follow the on-screen instructions.

See also Register and Activate Maya on page 27.

Install Maya Using Custom Settings on a Stand-Alone Computer

To install Maya using customized values on a stand-alone computer

With this method, you can set Maya to use a network license, change the
install location, and customize other settings.

1 Do one of the following to start the Maya Installation wizard:

■ If you are installing from a DVD, insert the DVD into your drive.
If the installer does not appear automatically, double-click the
setup.exe file on your DVD drive.

■ If you are installing from a download package, double-click the Maya
executable file that you downloaded.
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2 On the initial page, select a language for the installation instructions.
Click Install Products.

3 On the Select the Products to Install page, select your product(s) and the
product language. Click Next.

4 Review the Autodesk software license agreement. Click I Accept, and then
click Next.

5 On the User and Product Information page, enter your user information,
serial number, and product key. Click Next.

WARNING After you click Next, you cannot change the information entered
on this page unless you uninstall the product.

6 On the Begin Installation page, click Configure.

A window appears with tabs for each component you selected to install.
Each tab gives you a wizard for configuring additional installation options.
Select the tab for any component you want to change, then follow the
instructions to complete the configuration.

For example, if you select the Autodesk Maya 2011 tab, the Select the
License Type page displays first and lets you set whether to use a
stand-alone or network license.

NOTE If you select the Network license type, enter your license server name
in the field that appears. Contact your network administrator to find the
name of your license server.

7 (Optional) In the Installation Location and Select Preferences windows,
you can set the following options, then click Next.

■ Create the Desktop Shortcut for Maya - <Language>. Clear the check box
if you do not want to create a shortcut to the program.

■ Product Install Path - Specify the drive and location where you want to
install Maya.

8 Click another product tab to configure another product, or click Next
and then Configuration Complete to return to the Begin Installation
page. Click Install.

NOTE To retain a copy of your configuration settings, click Copy to Clipboard.
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9 On the Installation Complete page, note the directory path where you
can find and read the installation log.

10 Click Finish.

You have successfully installed Maya. You are now ready to register your
product and start using the program. To register the product, start Maya and
follow the on-screen instructions.

See also Register and Activate Maya on page 27.

Install Maya on Mac OS X
By default, Maya is installed in the following directory:
/Applications/Autodesk/maya2011/.

To install Maya on Mac OS X

1 Do one of the following to launch the installer:

■ If you are installing from a DVD, insert the DVD into your drive, then
double-click the Maya DVD icon that appears on your desktop.
Navigate to the Maya/MacOSX folder on the DVD drive.

■ If you are installing from a download package, double-click the Maya
.dmg.

2 In the Finder window that opens, double-click the Install Maya 2011
program.

The Autodesk Product Configuration wizard starts.

3 In the License Agreement window, do the following:

■ Select your Country or Region from the drop-down list.

■ Select I ACCEPT to accept the terms and conditions.

■ Click Next.

If you do not accept the terms and want to stop the installation, select I
REJECT and click Close.

4 In the Choose components window, select the components you want to
install and click Next. For example, this window lets you select from the
following components:

■ Maya 2011
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■ Maya 2011 Documentation

■ Composite

■ Backburner

■ MatchMover

5 In the Maya 2011 License Configuration window, do the following:

■ Enter your 11-digit serial number.

■ Enter your Product key.

■ Select your License type: Standalone or Network.
If you select the Standalone license type, obtain your stand-alone
license later by following the steps in Register and Activate Maya.

If you select the Network license type, enter your license server name
in the Server name field that appears. Contact your network
administrator to find your license server name.

■ Click Next.

An Installing Maya 2011 window displays with a progress indicator bar.

6 In the Installing Maya 2011 window, verify that the components you
want have finished installing, then click Done.

Install Maya on Linux
This section provides detailed information on installing Maya on Linux.

By default, Maya is installed in the following directory:
/usr/autodesk/maya2011-x64.

Install Maya on Linux using the Installation wizard

To install Maya on Linux

1 Do one of the following to start the Maya install:

■ If you are installing from a DVD, insert the DVD into your drive.

■ If you are installing from a download package, extract the Maya
packages from the compressed file.
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2 Open a shell as a super user and navigate to the directory where you
extracted the packages.

3 Type./setup and press Enter.

This starts the Autodesk Product Configuration wizard.

4 In the License Agreement window, do the following:

■ Select your Country or Region from the drop-down list.

■ Select I ACCEPT to accept the terms and conditions.

■ Click Next.

If you do not accept the terms and want to stop the installation, select I
REJECT and click Close.

5 In the Choose components window, select the components you want to
install and click Next. This window lets you select from components
including:

■ Autodesk Maya 2011

■ Autodesk Maya 2011 Documentation

■ MatchMover

■ Composite

■ Autodesk Backburner

6 In the Maya 2011 License Configuration window, do the following:

■ Enter your 11-digit serial number.

■ Enter your Product key.

■ Select your License type: Standalone or Network.
If you select the Standalone license type, obtain your stand-alone
license later by following the steps in Register and Activate Maya.

If you select the Network license type, enter your license server name
in the Server name field that appears. Contact your network
administrator to find your license server name.

(If you are setting up a license server, see the Network Licensing Guide
on page 79.)

■ Click Next.

An Installing Maya 2011 window displays with a progress indicator bar.
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7 In the Installing Maya 2011 window, verify that the components you
want have finished installing, then click Done.

Install Maya on Linux using the rpm utility
With the rpm command line utility, you can use either the -i flag or the -ivh
flag to install the programs. The -ivh flag provides you with more information
during the installation.

To install Maya on Linux using the rpm utility

1 Open a shell as a super user.

2 Do one of the following:

■ Insert the Maya DVD into your drive and mount the DVD drive. For
example, type: mount -r /dev/dvd /mnt/dvd.

■ Extract the Maya packages from the compressed file, then change to
the directory where you extracted the Maya packages.

3 Use the ls command to list the packages.

The packages you see will be similar to the following, where # indicates
the specific package numbers.

RequiredDescriptionPackage name

YesMaya for LinuxMaya2011_0_64-2011.0-
#.x86_64.rpm

NoMaya 2011 documentationMaya2011_0-docs_en_US_64-
2011-#.x86_64.rpm

YesAutodesk licensingadlmapps-1.3.#.x86_64.rpm

Only for standalone li-
censing (Not required

Autodesk standalone licens-
ing

adlmflexnetclient-
1.3.#.x86_64.rpm

if you use network li-
censing)

NoLicense server tools (for
network licensing)

adlmflexnetserver-
1.3.#.x86_64.rpm
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RequiredDescriptionPackage name

NoCompositeAutodeskToxik2011-2011.0-
#.x86_64.rpm

NoAutodesk Backburnerbackburner.sw.base-2011-
#.i386.rpm

NoAutodesk Backburner web
monitor

backburner_webmonit-
or.sw.base-2011-#.i386.rpm

NoAutodesk Backburner
monitor

autodesk.backburner.monitor-
2011-#.i386.rpm

NoMatchMoverMatchMover2011_0_64-
2011.0-#.x86_64.rpm

4 To install the required software, enter the following command:

rpm -ivh Maya2011_0_64-2011.0-#.x86_64.rpm adlmapps-

1.3.#.x86_64.rpm adlmflexnetclient-1.3.#.x86_64.rpm

where # indicates the specific package numbers.

NOTE If you have a previously installed version of AdLM and Maya for Linux,
uninstall that version before installing this version. To verify what version you
have, execute the following command: rpm -qa | egrep 'adlm|Maya'.

Maya 2011 adds the required libXm.so.3 library to the Maya lib directory
as part of its standard install, so installing the openMotif runtime rpm is
not required.

5 Look for a file named libGL.so in the /usr/lib/ or /usr/X11R6/lib

directory to verify that OpenGL is installed.

6 (Optional) To install the documentation package, type the following
where # is the specific package number:

rpm -ivh Maya2011_0_64-docs_en_US-2011.0-#.x86_64.rpm

The files are installed in the following directory:
/usr/autodesk/maya2011-x64

7 Run the following command to set whether you are using a network or
a stand-alone license:
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/usr/autodesk/maya2011-x64/bin/licensechooser

/usr/autodesk/maya2011-x64/ <licensetype> unlimited

where you specify standalone or network for <licenseType>.

This updates the license.env file (used by the Autodesk licensing software)
with your license type information.

8 Add /opt/Autodesk/Adlm/R1/lib64/to LD_LIBRARY_PATH to set your
shared libraries for this session.

For example, you can run the following command in a BASH shell:

export LD_LIBRARY_PATH=/opt/Autodesk/Adlm/R1/lib64/

9 Run the following commands to register Maya with the Autodesk licensing
software, where <productKey1> and <productKey2> are your product keys,
and <serialNum> is your serial number.:

■ (Stand-alone licensing)
/usr/autodesk/maya2011-x64/bin/adlmreg -i S <productKey1>

<productKey2> 2011.0.0.F <serialNum>

/var/opt/Autodesk/Adlm/Maya2011/MayaConfig.pit

■ (Network licensing)
/usr/autodesk/maya2011-x64/bin/adlmreg -i N <productKey1>

<productKey2> 2011.0.0.F <serialNum>

/var/opt/Autodesk/Adlm/Maya2011/MayaConfig.pit

NOTE If you purchased Maya alone and received only one product key, you
can enter the same product key for both <productKey1> and <productKey2>.

For example:

/usr/autodesk/maya2011-x64/bin/adlmreg -i S 657C1 657C1

2011.0.0.F 000-00000000

/var/opt/Autodesk/Adlm/Maya2011/MayaConfig.pit

This step updates the product information .pit file, which you can copy
to other machines that have the same configuration if you are installing
many instances of Maya.

These commands return a Registration succeeded message, and you
can now run Maya using your stand-alone or network license.
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Additional Linux Notes
This section provides information for configuring Maya to run on Linux,
describes differences between Maya for Linux and other versions of Maya, and
provides other information specific to using Maya on the Linux operating
system. For complete information on limitations and possible workarounds,
also refer to the Maya 2011 Release Notes.

Compiling plug-ins and standalone programs

To compile plug-ins and standalone applications for Maya 2011 on Linux,
use the released gcc 4.1.2 compiler. Maya has been compiled with this compiler
under RHEL 5.1 WS.

In addition, Maya uses some component libraries that may already exist on
your system (for example, Qt, Python, OpenAL, Intel TBB, MKL, Cg). These
libraries are installed in the /lib directory under your Maya installation
directory, and should not interfere with the normal operation of your Linux
system. In some cases, your system may include newer versions of these
libraries, which may or may not be compatible with Maya.

IMPORTANT Maya requires its own versions of the Qt libraries to run properly.

For more information, see the API Guide.

Installing additional required packages and fonts

On Linux, especially on Fedora systems, not all system libraries required to
run Maya are included in the default installation of the operating system. You
can use rpm to find and install any additional system-dependent library
packages and get the required runtime libraries.

For RHEL and Fedora, you can use the yum program to install the rpm packages.

For example, to install some of the following dependent libraries, you can
execute the following commands:

■ yum install mesa-libGLw

■ yum install libXp

■ yum install gamin audiofile audiofile-devel e2fsprogs-libs

Dependent OpenGL libraries (vendor Nvidia/AMD supplied)

■ libGL.so from Nvidia/AMD 3rd party library
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■ libGLw.so.1 from mesa-libGLw

Dependent X Windows libraries

■ libXp.so.6 from package libXp

■ libXmu.so.6 from package libXmu

■ libXpm.so.4 from package libXp

■ libXt.so.6 from package libXt

■ libXi.so.6 from package libXi

■ libXext.so.6 from package libXext

■ libX11.so.6 from package libX11

■ libXinerama.so.1 from package libinerama

■ libXau.so.6 from package libXau

■ libxcb.so.1 from package libxcb

Dependent System libraries

■ libfam.so.0 from package gamin

■ libaudiofile.so.0 from package audiofile

■ libaudiofile.so from package audiofile-devel

■ libuuid.so.1 from package e2fsprogs-libs

■ ibpthread.so.0

■ llibc.so.6

■ libdl.so.2

■ libz.so.1

■ librt.so.1

■ libSM.so.6

■ libICE.so.6

■ libutil.so.1

■ libssl.so.6
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■ libcrypto.so.6

IMPORTANT Note the following additional information on libssl.so.6 and
libcrypto.so.6.

libssl.so.6 and libcrypto.so.6 are versions of the OpenSSL library that ships
with RHEL 5.1. These are new dependencies for Maya 2011. Many Linux
distributions do not include this version of the library, and Maya does not
re-distribute this file with its installation package. For OpenSSL and Maya, it
is generally sufficient to create a symbolic link for the currently installed
system libraries to the same name with the so.6 version.

As root, create the symlinks in the Maya lib directory to isolate them from
the rest of your system. If the installer does not detect a libssl.so.6 library, it
should attempt the following.

su

cd /usr/autodesk/maya2011/lib

ln –s /usr/lib64/libssl.so.8 libssl.so.6

ln –s /usr/lib64/libcrypto.so.8 libssl.so.6

Dependent applications

■ tcsh
This is a command language interpreter application. Run the command
yum install tcsh to install.

Dependent 32-bit Backburner monitor libraries

■ php

■ elfutils-libelf

■ glibc

■ libgcc

■ libstdc++

■ httpd
To ensure that you install the required 32-bit version of these libraries, run
the following commands to install:

(Fedora 11)

yum install elfutils-libelf.i586 glibc.i686 libstdc++.i586

httpd php
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(Red Hat Enterprise Linux WS 5.4)

yum install elfutils-libelf.i386 glibc.i686 libstdc++.i386

httpd php

Fonts

Maya also uses some fonts that may not be installed by default. Execute the
following to install these fonts:

yum install liberation-mono-fonts liberation-fonts-common

liberation-sans-fonts liberation-serif-fonts

Differences in operation

When installed on a Linux system, Maya works in much the same way as
when installed on Windows.

Unsupported Maya features

Some of the features in the Windows versions are not currently supported.
These include output to AVI or SGI movie formats. Please refer to the Maya
2011 Release Notes for more information.

Linux desktop configuration

To use Maya on Linux, certain default keyboard and mouse bindings must be
changed from the factory settings. These default bindings prevent commands
from being received by Maya, such as the ones that let you tumble or pan a
view in a panel.

Different Linux window managers have different key bindings and different
procedures for setting them. Linux systems are highly customizable, and many
combinations of Linux system components are possible for use with
Maya—more than can be described (or tested) by Autodesk.

The following instructions give the procedures necessary for changing the
most common configurations.

KDE and Gnome desktop configuration

For Maya to work properly with KDE and Gnome, some modifications should
be made to the mouse control. The default bindings of the Alt key and mouse
buttons do not work well with Maya. Maya 2011 adds support to use the Meta
(Windows) key to act as the Alt key for tumbling. If you want to use the
Alt+mouse buttons for scene tumbling, ensure the bindings do not conflict.
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Different versions of KDE and Gnome may have different methods of selecting
the key bindings. See the KDE and Gnome documentation for instructions if
the following steps don’t work for your particular window manager.

KDE under Red Hat

1 Open the KDE Control Center.

2 Select Desktop and then select Window Behavior.

3 Do one of the following:

■ (Red Hat Enterprise Linux WS 5.4) Open the Actions tab.

■ (Fedora 11) Open the Window Actions tab.

4 In the following section:

■ (Red Hat Enterprise Linux WS 5.4) Inner Window, Titlebar & Frame

■ (Fedora 11) Interactive Inner Window, Inner Window, Titlebar &
Frame

For modifier key Meta, set all mouse action combinations to Nothing.

5 Click Apply and close the Control Center.

Gnome under Red Hat

1 Open the Gnome Panel.

2 Do one of the following:

■ (Red Hat Enterprise Linux WS 5.4) Select Applications, then Preferences
and then select Windows.

■ (Fedora 11) Select System, then Preferences and then select Windows.

3 In the Window Preferences dialog box, set the “To move a window...”
key to Super.

(Setting either Control or Alt here can cause problems when using Maya.)

4 Click Close.

Installing Multiple or Bundled Products
Some Autodesk packages are comprised of multiple products or are part of
multi-product bundles.
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In the installation wizard, for packages containing multiple products, you can
choose which products and languages you want to install. During the install
process, you are informed whether a copy of the software is already installed.
You are also warned if your system does not meet the minimum system
requirements for the product. Each product name is displayed on its own
tabbed panel; you can configure them individually.

If you purchased a package that is a multi-product bundle, such as an
educational or institutional package, you may have a package that includes
several Autodesk products. For these bundled packages, an Installer disc
contains information for all the products in the package. The Installer disc
helps you install all of the products. This includes a Readme which describes
issues general to the bundle or suite.

NOTE If you are installing Maya as part of a suite, it is recommended that you
refer to both the suite install guide and this install guide.

Register and Activate Maya
The first time you start Maya, the Product License Activation wizard is
displayed. You can either activate Maya at that time, or Try Maya and activate
it later. Until you register and enter a valid activation code for Maya, you are
operating the program in trial mode and the Product License Activation wizard
is displayed for 30 days from the first time that you run the program.

If after 30 days of running Maya in trial mode you have not registered and
provided a valid activation code, your only option is to register and activate
Maya. You will not be able to run in trial mode after the 30 days expires. Once
you register and activate Maya, the Product License Activation wizard is no
longer displayed.

The fastest and most reliable way to register and activate your product is by
using the Internet. Simply enter your registration information and send it to
Autodesk over the Internet. Once you submit your information, registration
and activation occur quickly.

To register and activate Maya

1 Click the Start menu  ➤  Programs or All Programs ➤  Autodesk  ➤ 

<Maya>  ➤  <Maya>.

2 In the Maya Product License Activation wizard, select Activate, and then
click Next.

This starts the activation process.
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3 Click Register and Activate (Get an Activation Code).

4 Click Next and follow the on-screen instructions.

If you do not have Internet access, or if you want to use another method
of registration, you can register and activate Maya in one of the following
ways:

Email Create an email message with your registration information and
send it to Autodesk.

Fax or Post/Mail Enter your registration information, and fax or mail
the information to Autodesk.

Launch Maya
Assuming that you followed all of the previous steps outlined in this
installation section, you can launch Maya and start taking advantage of its
new and updated features. For more detailed information about the new
features, learning videos, online Help, or Maya services and support, see the
Welcome screen after you launch the product.

You can start Maya in the following ways:

■ Desktop shortcut icon. When you install Maya, an Maya shortcut icon is
placed on your desktop unless you cleared that option during installation.
Double-click the Maya shortcut icon to start the program.

■ Start menu. On the Start menu, click Programs or All Programs  ➤  Autodesk
 ➤  <Maya>  ➤  <Maya>.

■ Location where Maya is installed. If you have administrative permissions,
you can run Maya in the location where you installed it. If you are a
limited-rights user, you must run Maya from the Start menu or from the
desktop shortcut icon. If you want to create a custom shortcut, make sure
that the Start In directory for the shortcut points to a directory where you
have write permissions.

Uninstall Maya
The following sections describe how to uninstall Maya 2011.

NOTE If you uninstall Maya 2011, Composite and MatchMover will be disabled.
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Uninstall Maya on Windows
When you uninstall Maya, all components are removed. This means that even
if you've previously added or removed components, or if you've reinstalled
or repaired Maya, the uninstall removes all Maya installation files from your
system.

There are two ways to uninstall Maya on Windows.

To uninstall Maya using the Uninstall utility

1 From the Start menu, select Programs > Autodesk > Autodesk Maya 2011
> Uninstall Maya.

2 Follow the instructions in the window that appears.

To uninstall Maya using the Windows uninstall utility

1 Open the Control Panel and do one of the following:

■ (Windows XP) Launch the Add or Remove Programs window.

■ (Windows 7 and Windows Vista) Select Programs or Programs and
Features.

2 In the list of programs that appears, select Maya 2011 and click Uninstall
or Remove.

3 Follow the instructions in the window that appears.

Uninstall Maya on Mac OS X

To uninstall Maya on Mac OS X

1 Navigate to the Maya directory (by default,
/Applications/Autodesk/maya2011/).

2 Drag the maya2011 application to the trash.

3 Open a Terminal window and execute the following commands, where
<productKey> is your product key.:

adlmreg –u S <productKey> 2011.0.0.F

adlmreg –u N <productKey> 2011.0.0.F
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This ensures that product information is properly removed from the
ProductInformation.pit file.

Uninstall Maya on Linux
To uninstall Maya on Linux you can use the rpm utility.

To uninstall Maya using rpm

1 Open a shell as a super user.

2 Add /opt/Autodesk/Adlm/R1/lib64/ to LD_LIBRARY_PATH to set your
shared libraries for this session.

For example, by running the following command:

export LD_LIBRARY_PATH=/opt/Autodesk/Adlm/R1/lib64/

3 Run both of the following commands, where <productKey> is your
product key:

/usr/autodesk/maya2011-x64/bin/adlmreg -u S <productKey>

2011.0.0.F

/usr/autodesk/maya2011-x64/bin/adlmreg -u N <productKey>

2011.0.0.F

4 List the installed package names by entering:

rpm -qa |egrep 'adlm|Maya'

5 Identify each package name you want to uninstall. For example, the
Maya-2011-# package (where # is the package number).

6 Uninstall each package using the following command:

rpm -e PackageName

Network Administration and Deployment

Preparing a Deployment
To prepare for a deployment, you should take the time to review the following
requirements and options.
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IMPORTANT While some of the concepts and procedures in the following sections
may prove useful as guidelines for network administrators using Mac OS X and
Linux, only the Windows version of the Maya installer includes a deployment
wizard. Also note that most images and examples in this section are based on
AutoCAD.

System requirements for Administrative image
Before you begin installing the program on a network, make sure that your
servers and client workstations meet the minimum recommended hardware
and software requirements for a deployment. For complete system
requirements, see www.autodesk.com/qual-charts.

The program will automatically detect if the Windows operating system is the
32- or 64-bit version when installing Maya. The appropriate version of Maya
will be installed. The 32-bit version of Maya cannot be installed on a 64-bit
version of Windows vice-versa.

Choose an installation type
When you set up your deployment, you need to choose the type of installation
to deploy. In the Deployment wizard, you specify one of the following
installation types:

Stand-Alone installation (Stand-Alone option)

Choose this type of installation for stand-alone installations where a single
serial number and product key are used for a single seat. Like a multi-seat
stand-alone installation, you do not use the Network License Manager to
manage product licensing, but installation, registration, and activation occurs
on each workstation.

Multi-Seat Stand-Alone installation (Stand-Alone option)

Choose this type of installation for stand-alone installations where a single
serial number and product key are used for multiple seats. Multi-seat
stand-alone installations do not rely upon the Network License Manager to
manage product licenses; however, you can still use the Deployment wizard
to create administrative images and deployments. Registration and activation
is more automated for multi-seat stand-alone installations. After the first
activation using the multi-seat stand-alone serial number and product key,
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activation occurs automatically for all workstations based on this deployment,
as long as your systems are connected to the Internet.

Network License installation

With this type of installation, you install the program to workstations with
the files and registry entries that allow the program to communicate with the
Network License Manager. You also define the configuration of the Network
License Manager so that the licenses can be accessed. Workstations running
the program based on a network installation do not require individual
activation. Licensing of this program is managed by at least one license
server.The main advantage is that you can install Maya on more systems than
the number of licenses you have purchased (for example, purchasing 25
licenses but installing on 40 workstations). At any one time, Maya runs on
the maximum number of systems for which you have licenses. This means
you get a true floating license.

Create a Network Share
Once you have fully prepared for creating a deployment, you are ready to set
up and distribute Maya by creating a network share location (folder). A network
share is an installation folder that you make available to users' computers on
a network. You point users to this location to install the program.

NOTE You must have Full Control permissions set for your shared folder when
you are creating your deployment images. Read permissions are necessary to
access the network share and administrative permissions on the workstation where
the program is deployed.

To create a network share folder

1 On your network server’s desktop, create a folder named Deployments.

2 Right-click the Deployments folder and click Share and Security (or Sharing).

3 In the <folder name> Properties dialog box, Sharing tab, select Share This
Folder.

4 Specify a Share Name, such as Deployments, if necessary.

5 Click the Permissions button. In the Permissions dialog box enter your
group or user names, and make sure Full Control is selected. Click OK.
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In Vista, right-click the Deployments folder and then click Share. In the
File Sharing dialog box type in or browse to the name of the group or
user you want to share the folder with. Click Add, and then click Share.

6 For each product you plan to install, create a subfolder in the Deployments
folder. Name each folder with the pertinent product name.

(Windows) Setting Up and Creating a Deployment
The deployment process provides you with numerous options for creating,
and customizing your deployments, so you should set aside ample time to
complete the process in one sitting. To be successful, it is recommended that
you review the following checklist and information before you begin. The
deployment process is initiated from the installation wizard’s Create
Deployments selection. Once a deployment is created, users then access the
deployment to install products to their computers.

Prepare for a Network Deployment
Complete the following preliminary tasks before creating a network
deployment.

Deployment Checklist

Review the system requirements. Confirm your network, servers, and client
workstations meet the system requirements.

Understand the type of license you have purchased. For a network license de-
ployment, you should also be familiar with the type of license server model you
want to use, and the license server name(s).

Install and activate any support tools and utilities.

Locate your product serial number and product key. These are located on the
outside of the product packaging, or in the Autodesk Upgrade and Licensing
Information email message.

Determine how you intend to personalize the program(s) during registration.
Using consistent registration data is very important.
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Deployment Checklist

Identify the location, and create a shared folder where deployments will reside
for each program you plan to deploy.

Close all other programs and disable anti-virus software.

Decide which language to use for each of your deployment packages.

NOTE Languages can be included only during the creation of the deployment,
not during modification.

Determine whether your deployment plan involves using imaging software to
distribute your program(s) to client workstations.

Determine whether to create log files that contain deployment and installation
data, and whether to run silent mode.

NOTE When the program is installed from a deployment using silent mode,
users’ systems automatically reboot without warning when the installation is
complete.

Determine an installation type (Typical or Custom).

Determine your user preferences—including whether to display the Welcome
Screen, whether to require Internet Explorer, the default publishing format, and
whether to create a desktop shortcut.

Set up access to online resources, such as Subscription Center, Help, Customer
Error Reporting.

Your Deployment Choices

Enter User and Product Information
The User and Product Information page is used to personalize the program
for your environment. The information you enter is permanently retained
with the product and is displayed in the Help menu on all workstations.
Because you can't change this information later without uninstalling, take
care when entering the information.
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You must also enter the product serial number and product key in order to
run the product. The serial number and product key are located on the outside
of the product packaging, or in the Autodesk Upgrade and Licensing
Information email. The serial number must contain a three-digit prefix followed
by an eight-digit number. The product key consists of five characters.

Creating Log Files
From the General Deployment Settings dialog, you can setup two types of log
files with which you can monitor information about deployments and
installations.

■ Create network log The network log file keeps a record of all workstations
that run the deployment. On the General Deployment Settings page, you
choose whether or not to create a network log file. The log lists the user
name, workstation name, and the status of the installation. Refer to this
file for status information and details about problems that users
encountered during installation (for example, low disc space or inadequate
permissions).
The network log is named with the same name you chose for your
deployment. You can specify where the log file is created by entering either
a valid UNC (universal naming convention) path or hard-coded path on
your network, for example \\MyComputer\Autodesk\<Autodesk product>.
Users should use their actual computer name in place of MyComputer.

NOTE The folder where the network log resides must be a shared folder where
users who install the program have Change permissions. Otherwise, successes
or failures for user installations cannot be written to the log file.
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■ Create client log The client log contains detailed installation information
for each workstation. This information may be useful in diagnosing
installation problems. The client log is located in the %Temp% directory
of each client workstation.

What Is Silent Mode?
When silent mode is active and a user initiates the deployment, the installation
proceeds without any explicit user input. Users cannot change any of your
installation settings. No dialog boxes are presented that require interaction
from the user.

WARNING When the product is installed from a deployment using silent mode,
users’ systems will reboot automatically and without warning when the installation
is complete.

Create a Default Deployment
If you do not plan to customize your deployment, you can create a default
deployment.

The following procedure illustrates how quickly you can set up a default
deployment using the deployment wizard. This procedure illustrates a
single-server network deployment using a Typical installation with no
customizations. For information about customizing product configurations in
a deployment, see Create a Custom Deployment.
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To create a deployment using default settings

1 Start the Maya Installation wizard.

2 On the initial page, select a language for the deployment instructions.
Click Create Deployments.

3 On the Begin Deployment page, specify the following:

■ Administrative Image Field. Enter or locate the path to the shared network
location where you want to create and store your administrative image.
Users install the program from this location.

NOTE For information on how to create a network share, see Create a
Network Share on page 32.

■ Deployment Name Field. Enter the new deployment's name. This name
is used for the shortcut from which users will install the product.

■ This is to be a: Select either 32-bit or 64-bit for your target operating
system.

Click Next.

4 On the Select the Products to Include in the Deployment page, select the
products, and language to include in your deployment. Click Next.

5 Review the Autodesk software license agreement. Click I Accept, and then
click Next.

6 On the User and Product Information page, enter your user information,
serial number, and product key. Click Next.

WARNING After you click Next, you cannot change the information entered
on the this page unless you uninstall the product.

7 On the General Deployment Settings page specify whether to

■ Create a network log file. Specify the log file’s location by entering
either a valid UNC (universal naming convention) path or a
hard-coded path on your network.

NOTE The folder that contains the network log file must be a shared
folder for which users who install the program have Change permissions.
Otherwise, successes or failures for user installations cannot be written to
the log file.
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■ Create a client log file.

■ Run the installation in silent mode to prevent users from changing
installation settings.

For more information on log files, see Creating Log Files on page 35. For
more information on silent mode, see What Is Silent Mode? on page 36.

Click Next.

8 On the Create Deployment page, click Create Deployment. Click Yes to
continue creating the deployment using the default configuration.

An administrative image is created in your shared folder using the
deployment options listed in Current Settings. To retain a copy of your
deployment settings, click Copy to Clipboard.

9 On the Deployment Complete page, click Finish.

Modify a Deployment (Optional)
After a deployment is created, it may be necessary to modify the deployment
for some client workstations. You can apply a patch or include various custom
files that are not part of the base administrative image. You can also perform
modifications such as changing the installation directory from drive C to drive
D.

To modify a deployment

1 Open the shared network folder where you originally chose to place your
product deployment.

2 In the Tools folder, double-click the Create & Modify a Deployment
shortcut.

The deployment wizard is redisplayed.

3 Click through the deployment pages and make the necessary changes.

4 Click Create Deployment.

Point Users to the Administrative Image
When you are done creating the deployment, users can install the program
using the shortcut located with the administrative image. The shortcut name
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matches the deployment name that you specified in the deployment wizard.
Notify users of the location of the administrative image, instruct them to
double-click the shortcut, and provide any other necessary instructions.

Distributing an Autodesk Program
You can choose from several methods of distributing an Autodesk program.
Network sharing is the default method.

■ Network Share. Users launch the program with the shortcut icon that you
created with the deployment wizard. The program is installed on users'
local computers, and a product icon appears on their desktop.

NOTE Users must have Read permissions to access the network share and
administrative permissions on the workstation where this program is installed.

■ Scripting. See Use Scripts to Deploy the Program on page 39.

■ Group Policy Objects (GPOs). See Use Group Policies to Run a Deployment.

Use Scripts to Deploy the Program
A script executes a command or a set of commands. Scripts are similar to batch
files but are more flexible. Installation scripts are most useful for stand-alone
installation of programs on computers that are connected to a network. Scripts
are also useful for installing service packs, extensions, and object enablers on
a network.

You create a script by using a text editor such as Notepad and then saving it
in ASCII format in a file with the file extension .vbs. The script consists of one
or more commands, as well as command switches that specify options, and
flags that modify the options. An installation script also contains path names.

An installation script points to the location of the product's setup.exe file. You
must point to the setup.exe file on your product disc. For example:

Autodesk product CDROM1\setup.exe
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In order for Maya to run properly, the following software and prerequisites
must be installed and met on the computer where the program is being
installed:

■ Microsoft Internet Explorer version 6.0 Service Pack 1 or later (You can
download Microsoft Internet Explorer from the Microsoft website by visiting
www.microsoft.com)

■ Microsoft Scripting Engine
The sample scripts in this section are based on Microsoft Scripting Engine
5.6, which works with both VBScripts and JavaScript. If you don't have
the scripting engine installed, you can download it for free from the
Microsoft website at www.msdn.microsoft.com/scripting. Sample scripts and
Help files are also available there for download.

■ Administrative permissions

A Sample Installation Script
The sample script in this section installs the program in a typical configuration.
To make it easy to copy this sample script and substitute your own information,
the same names are used throughout for variable items. The log file name is
based on the product being installed. You can either use the log file name in
the script or change it to something else.

Serial number prefix: 123

Serial number: 12345678

First name: My First Name

Last name: My Last Name

Organization: Organization

A sample script for a silent installation of this program uses the syntax shown
in this section.

Scripted installation for AutoCAD LT

' Scripted installation for AutoCAD LT 2011

option explicit

'
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' Create variables

dim shell

dim productType

dim strADSKFirstName

dim strADSKLastName

dim strADSKOrganization

dim strADSKSNPrefix

dim strADSKSNNumber

dim strADSKProdKey

dim strADSKPath

dim strSourcePath

'

' Script initialization

Set shell = CreateObject("WScript.Shell")

productType = "ACADLT"

'

' Name and Organization information

strADSKFirstName = "My First Name"

strADSKLastName = "My Last Name"

strADSKOrganization = "Organization"

'

' Serial Number information

strADSKSNPrefix = "123"

strADSKSNNumber = "12345678"

strADSKProdKey="ABCDE"

'
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' Source to install from (e.g. D: is assumed to be Install Media)

strSourcePath = "D:\"

'

' Destination to install to

strADSKPath = Shell.ExpandEnvironmentStrings("%ProgramFiles%") +

"\Autodesk\" + "AutoCAD LT 2011"

strADSKPath = strADSKPath + "\"

RunStandaloneInstall()

' End of Script

Wscript.quit()

function RunStandaloneInstall()

dim retString

'

retString = """" & strSourcePath & "\setup.exe" & """" & "/w /t

/qb "

retString = retString & " /c " & productType & ": "

retString = retString & "INSTALLDIR=" & """" & strADSKPath & """"

& " "

retString = retString & "ACADSERIALPREFIX=" & strADSKSNPrefix &

" "

retString = retString & "ACADSERIALNUMBER=" & strADSKSNNumber &

" "

retString = retString & "ADLM_PRODKEY=" & strADSKProdKey & " "

retString = retString & "ACADFIRSTNAME=" & """" & strADSKFirstName

& """" & " "

retString = retString & "ACADLASTNAME=" & """" & strADSKLastName

& """" & " "

retString = retString & "ACADORGANIZATION=" & """" & strADSKOrgan

ization & """" & " "

retString = retString & "InstallLevel=5 "

shell.run retString,2,1

end function

Use Switches and Flags in Scripts
The following table lists all of the switches and flags that are relevant to
installation.

42 | Chapter 2   Maya Installation



NOTE  You must set the installation switch to INSTALLDIR=. If this is not done,
programs that run outside Maya (such as the License Transfer utility) are not
installed.

Switches in Installation Scripts

DescriptionSwitch

Specifies the location to install the product.INSTALLDIR=

Specifies the numbers that precede the hyphen
in the serial number.

ACADSERIALPREFIX=

Specifies the serial number.ACADSERIALNUMBER=

Specifies the type of installation: 3=TypicalINSTALLLEVEL=

Specifies the first name personalization.ACADFIRSTNAME=

Specifies the last name personalization.ACADLASTNAME=

Specifies the company name.ACADORGANIZATION=

Specifies the product key (found on the same label
as the serial number).

ADLM_PRODKEY=

User Interface Flags

DescriptionFlag

Designates that the installation is performed in silent mode.q

Run Scripts
After creating a script, you move it to a server or use a mapped drive letter or
a UNC (universal naming convention) path. If you place it on a server for
users to run, create a share on the server, and then add users to the share with
the rights they need. Because all that users need to do is run the script, provide
read-only access to the share directory.

Next (on the same server or on a different server), create a directory for each
product you want to install. Choose a location for this directory that won't
be changed so that you can point to the MSI files in your scripts. Copy the
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product disc(s) to that directory. You may also want to create directories for
service packs, extensions, and your own customization tools.

You can use any of the following methods to run an installation script:

■ Run the script manually at each individual workstation. To run the
installation, paste the script into the Run dialog box or run it from the
Windows command prompt.

■ Send an email with the UNC path to each user who should run the script.
To run the script, the user follows your instructions.

■ Email the script to each user with instructions for use.

■ Set up the script so that it runs on login.

Use Group Policies to Run a Deployment
With group policies, you can advertise and install a program by assigning a
deployment to computers. A deployment that is assigned to a computer can
be used by any user of that computer. Generally, you would assign the
deployment to a computer that is used by a large number of users.

NOTE Autodesk products are designed to be installed on a computer so that any
user who logs on to the computer can run the software. If you assign a deployment
to a specific user rather than a computer, you may encounter problems when a
second specified user tries to install or uninstall a copy of the program.

The following outlines the advantages and disadvantages of using group
policies.

Advantages

■ Works well with deployment functionality.

■ Allows you to add custom files through the deployment wizard.

■ Allows deployment to workstations.

Disadvantages

■ Prohibits the passing of command-line parameters to an MSI executable.
You must use scripts instead.
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■ Prohibits customization of application settings, other than what is set
while creating a deployment.

There are three main steps to distributing this program through group policies.

■ Create an application distribution share point. The application distribution
share point is created using the deployment wizard. See Create a Default
Deployment on page 36 or Create a Custom Deployment to create a
deployment.

■ Assign the deployment to a computer. See Use Group Policies to Assign a
Deployment to Computers.

■ Verify the installation. Confirm that the program has been correctly
installed. See Verify a Group Policy Deployment on page 49.

Use Group Policies to Assign a Deployment to Computers
Perform the following procedures from a Windows XP workstation or a
Windows 2000 or 2003 server that has Group Policy Management Console
installed, and has access to the Active Directory server.

NOTE For more information about Group Policy Management, see
http://technet.microsoft.com/en-us/windowsserver/grouppolicy.

To assign a deployment to a computer

1 Start the Group Policy Management Console (gpmc.msc).

2 Right-click the organizational unit where you want to create the group
policy object. Then select Create and Link a GPO Here and name the
Group Policy.

3 Edit the policy.

4 In the Group Policy Object Editor dialog box, under Software Settings,
right-click Software Installation, and click New  ➤  Package.

5 In the Open dialog box, navigate to the administrative image’s location
that you specified in the deployment wizard. Navigate to
AdminImage\<processor type>\<product name folder>. The processor type is
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either x86 or x64, depending on the processor type for which you created
your deployment.

Examples

For x86 deployments:
\\server123\Deployment\AdminImage\x86\acad

For x64 deployments:
\\server123\Deployment\AdminImage\x64\acad

6 Select the Windows Installer Packages file called acad-<deployment
name>-for-GPO.msi. Click Open.

If the deployment was called “Maya 2011 32 bit,” then the deployment’s
the MSI file would be acad-Maya 2011 32 bit-for-GPO.msi.

7 In the Deploy Software dialog box, select Advanced and click OK.
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8 In the Properties dialog box, Modifications tab, click Add.

9 In the Open dialog box, select the Transform Package file called
acad-<deployment name>.mst). Click Open.

10 In the Properties dialog box, Modifications tab, click Add.

11 In the Open dialog box, navigate to <deployment location>\Tools and select
the Transform Package file called gpo.mst.
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After clicking Open, the Properties dialog should look like the following:

12 Click OK to complete the package.

48 | Chapter 2   Maya Installation



The group policy object is now assigned to all computers that are members
of the organizational unit for which the group policy object has been created.
The next time a computer in the organizational unit is restarted, the program
will be installed and will be available for all users of the computer. See Verify
a Group Policy Deployment on page 49 to confirm that the group policy has
been created correctly.

Verify a Group Policy Deployment
To verify that this deployment has been correctly assigned to a computer,
restart a computer that is in the organizational unit for which the group policy
was created. The program installation begins before the login prompt is
displayed. The operating system displays group policy messages, including a
message indicating the installation of any managed software.

After logging in, double-click the program icon on the desktop to complete
the installation and start the program.

NOTE If problems arise, an entry is logged in the system's Event Viewer under
Applications.

Distribute the Product Using Imaging Software
The following information is provided for those who use imaging software,
such as Norton Ghost, to create a master image to distribute Autodesk products.
Once created, the master image is then replicated to other computers
throughout your facility.

NOTE Autodesk does not recommend or support the distribution of Maya using
imaging software. However, if you plan to use this method of distribution, please
review the following instructions carefully.

Care needs to be taken since the use of imaging software can result in the
following situations:

■ Conflicts with the product licensing

■ Incomplete installations and problems with activation

Distribute the Product Using Imaging Software | 49



NOTE If you are experiencing licensing instability in a SATA RAID environment,
using imaging software to distribute Autodesk products can cause product
activation problems, such as “Activation code limit exceeded” when you attempt
to activate.

Use a Master Image to Distribute Multi-Seat Stand-Alone
Products to Multiple Systems

You can distribute the product using a master image for a multi-seat
stand-alone product.

NOTE When using Norton Ghost, you must use the -ib switch to include the boot
sector in your master image. Consult your imaging software for more details on
including the boot sector as part of the master image.

Master images should not be created if you’ve previously run Autodesk products
on the master computer. Cleaning the system may be necessary.

To distribute a multi-seat stand-alone product to multiple computers using
a master image

1 Create a network deployment for a multi-seat stand-alone product. For
more information, see Create a Custom Deployment.

2 Install Maya from the deployment onto the master computer.

3 Do one of the following on the master computer:

■ Create a master image, including the boot sector. Test the product on
a machine other than the master computer before distributing the
product. Launch the product on the other machine, and register and
activate it. Users have a 30-day grace period to register and activate
the product on their machines.

■ Launch and customize the product as necessary. Create a master image
and distribute it to users. If users’ computers are connected to the
Internet, the product is automatically activated. Users whose
computers are not connected to the Internet have a 7-day grace period
to register and activate the product.

4 Apply the master image to the target computers.
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Restore the Master Image
The following procedure assumes that you have saved a copy of each
workstation’s AdLM folder (and Product Licenses folder, if present) to either
another workstation or a disc before you reformat the workstation.

To restore a product using a master image

1 Exit the application. Do not run the application again until after you
have completed this procedure.

2 In Windows Explorer, copy the AdLM folder from the appropriate path
shown below to a location other than the disc that will be restored.

C:\Documents and Settings\All Users\Application Data\FLEXnet

3 Reformat the workstation and restore the master image.

NOTE Do not perform a low-level format of the hard drive.

4 Copy the AdLM folder that you created in step 2 to its original workstation
and location on that workstation.

NOTE When you restore the disc image, any files that were altered are put back
in their original state and ready to use again. The license files are preserved, and
no reactivation of products is necessary.

Clean a Master System and Restore the Operating System
If you have already run Maya on the master computer, the master computer
should be properly cleaned first.

To clean a master computer and restore the operating system

1 Clean the hard drive, including the boot sector.

For example, if you use Norton’s GDISK utility, use the following
command:

gdisk 1 /diskwipe

Where 1 is the hard disk that is being wiped.

NOTE If you use a utility other than Norton Ghost, make sure that it cleans
the boot sector; otherwise, you will not be able to activate Autodesk products.
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2 Create a new partition and use the restore disc or product disc to install
the operating system.

Install mental ray for Maya satellite

Overview of mental ray (satellite)
mental ray for Maya supports a different form of network rendering: mental
ray satellite rendering. The new network rendering capability, based on mental
ray satellite technology, allows you to install a version of mental ray (satellite)
on any networked computer. This special version of mental ray resides on
that machine and waits for rendering tasks from Maya. It supplements the
mental ray rendering capabilities in Maya with the additional rendering power
provided by the networked computers’ CPUs.

A mental ray distributed rendering can speed up all of the following tasks:

■ interactive rendering (through the Maya interface)

■ IPR rendering with mental ray for Maya

■ interactive batch rendering (a batch render started by Maya)

■ command-line rendering

The rendering process is typically initiated from the master machine (the
machine running Maya or where the command-line render starts from). The
slave machines (satellite rendering computers) process rendering tasks they
receive over the network from the master and send back results. The master
machine handles task distribution, load balancing, and the collection of
received rendering tasks which make up the rendered image.

For more information about mental ray satellite, including how to set up the
rayhosts file to get and receive data from Maya, see the Maya Help. In the
Maya Help, navigate toUser Guide > Rendering and Render Setup > Rendering
> mental ray for Maya rendering > Network rendering using mental ray for
Maya.

Setting up the rayhosts file is required for mental ray for Maya satellite
rendering to work.
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Slave machine installation
The special version of mental ray standalone with satellite rendering
technology must be installed on all slave machines. The satellite-enabled
versions of mental ray for Windows, Mac OS X, and Linux are included with
this release of Maya on the Maya DVD.

(Windows) To install mental ray standalone with satellite licensing

1 On each slave machine, begin the installation process by inserting the
Maya DVD, opening the mental ray satellite folder and the
platform-specific Windows folder, and double-clicking the mental ray
standalone installer.

The installer appears.

2 Follow the installation steps.

During the installation, you can click Custom to change the installation
directory. The default installation directory is:

C:\Program Files\Autodesk\mrsat3.8.1-maya2011

(Mac OS X) To install mental ray standalone with satellite licensing

1 On each slave machine, begin the installation process by inserting the
Maya DVD, opening the mental ray satellite folder and double-clicking
the mental ray standalone installer.

2 Follow the installation steps.

During the installation, you can change the installation directory. The
default installation directory is:

/Applications/Autodesk/mrsat3.8.1-maya2011

(Linux) To install mental ray standalone with satellite licensing using rpm

1 Log in as root.

2 On each slave machine, begin the installation process by inserting the
Maya DVD.

3 Mount the DVD drive, if necessary. For example, type:

mount -r /dev/dvd /mnt/dvd

4 Open the mental ray satellite directory, go to the Linux directory, and
enter the following command (where # is the specific package number):
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rpm –ivh mentalraySatellite3.8.1_maya2011-3.8-#.x86_64.rpm

NOTE 64-bit Windows releases of mental ray for Maya satellite use the same
port and service name as the 32-bit version. You will run into problems if you
install both the 32-bit and the 64-bit versions on a 64-bit system. There is
only one service entry/xinetd config, so installing a 64-bit package after the
32-bit (or the other way around) leaves only the last installed version working.

Slave machine additional setup
Once this version of mental ray is installed and running, a service on the
machine (the Ray Sat server) waits for rendering tasks from mental ray for
Maya on the master machine. The satellite-enabled version of mental ray does
not require its own licensing; it is activated through Maya’s licensing.

On the slave machine, the Ray Sat server (service name: mental ray Satellite
3.8.1 for Maya 2011) must be running. To verify that it is running on Windows,
follow this procedure.

To verify that Ray Sat server is running (Windows)

1 Open a Windows command prompt.

2 Navigate to the bin directory of the mental ray satellite standalone. By
default this is C:\Program Files\Autodesk\mrsat3.8.1-maya2011\bin\.

3 Type the following:

raysat2011server /query

A message should be returned that the RaySat2011 Server service is
running.

If you do not get this message, make sure that RaySat2011 Server has
been installed as a service, and start it from the Services Control Panel
(Settings > Control Panel > Administrative Options > Services) or type
the following:

raysat2011server /start

Slave machine port setup
On the slave machine, port number 7411 is set by default. This works well in
the majority of cases and you won’t need to change the port number.
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If you want to change the port number that mental ray satellite uses to a value
other than 7411, you must edit the services file. The port value would be
determined by your network administrator (a free TCP/IP port).

To change the port number (Windows, Linux)

1 Edit the services file with a text editor.

The services file is located at:

■ (Windows XP) C:\Windows\system32\drivers\etc\services

■ (Linux) /etc/services

2 Change the number in the following line (here, 7411) to the desired port
number:

mi-raysat2011 7411/tcp

To change the port number (Mac OS X 10.4, Tiger)

1 Log in as superuser (sudo -s).

2 Open the file /etc/services using your preferred text editor.

3 Edit the line: mi-raysat2011 7411/tcp.

4 Save the file.

5 From the Finder menu, select Go > Applications and then double-click
the Utilities folder.

6 Double-click the NetInfo Manager icon.

7 Under the Services directory of the NetInfo database, find and select the
appropriate service (mental ray Satellite 3.8.1 for Maya 2011).

8 Click the lock icon at the bottom of the panel and then enter your
administrator user name and password. This allows you to unlock the
NetInfo database and make changes.

9 Select the port field and change its value to the desired port number.

10 Click the lock icon again when you’re done.

11 From the Finder menu, select Domain > Save Changes to commit your
changes to the NetInfo database.

12 Reboot your machine.
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To change the port number (Mac OS X 10.5, Leopard)

1 Log in as superuser (sudo -s).

2 Open the file /etc/services using your preferred text editor.

3 Edit the line: mi-raysat2011 7411/tcp.

4 Save the file.

5 Open a Terminal window and do the following:

sudo /usr/bin/dscl . -change /Services/mi-raysat2011port <cur

rentportnumber> <newportnumber>

For example:

sudo /usr/bin/dscl . -change /Services/mi-raysat2011 port 7109

7411

NOTE To determine the port you’re currently using, in a Terminal window,
type: /bin/dscl . -read /Services/mi-raysat2011

6 Reboot your machine.

Licensing of satellite rendering
For standalone licenses, the use of mental ray for Maya with satellite can only
be initiated from the specified host for which your received your Maya key.
The workstation can distribute mental ray for Maya rendering to up to eight
slave CPUs.

For networked licenses, use of the functionality is slightly more flexible. For
networked license setups, the license running Maya and the license running
mental ray for Maya can be logged out separately, allowing certain rendering
tasks to be initiated remotely.

There are two possible cases when using mental ray for Maya with networked
licenses:

■ (Interactive) With Maya running interactively on a workstation, initiate a
mental ray for Maya render (either a single frame in the Render View, Batch
render or command line render) on the workstation. The networked mental
ray for Maya portion of your license is logged out. This allows the mental
ray satellite slaves indicated in your rayhost file to participate in the render.
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■ (Offline) If you launch a command line mental ray for Maya render, the
computer you launched the command from then becomes the master
machine for mental ray for Maya satellite rendering.

NOTE If you have launched Maya but have not yet rendered with mental ray
for Maya since the start of your interactive session, no mental ray for Maya line
item from your networked license is checked out. You may therefore start a
command line mental ray for Maya render from another host. This checks out
the mental ray for Maya portion of the license, making it unavailable for any
other workstation, including the workstation of the user who launched Maya.

For more details on mental ray rendering, see the Rendering sections of the
Maya Help, as well as the mental ray reference included with the Maya Help.

Installation Troubleshooting
This section provides solutions to installation issues and answers to commonly
asked questions that may arise while installing your product(s). Additional
troubleshooting information and support is also available at
http://autodesk.com/servicesandsupport

General Installation Issues
This section outlines common issues and their solutions that may arise while
performing a general install of your product(s).

How can I check my graphics card driver to see if it needs to be
updated?

It is recommended that you verify and update your graphics card driver to
optimize your program. Use the following procedure to identify your current
graphics card driver.

To identify your graphics card driver

1 On the Start menu (Windows), click Settings  ➤  Control Panel.

2 Click the Display icon to access the Display Properties.

Installation Troubleshooting | 57

http://usa.autodesk.com/adsk/servlet/index?siteID=123112&id=1068444


In Vista, click Settings  ➤  Control Panel  ➤  Personalization  ➤  Display
Settings.

3 Open the Settings tab and click the Advanced button.

4 Click the Adapter tab to check the adapter type.

5 Click the Properties button and open the Driver tab to check driver version
and see if newer drivers are available.

TIP Many newer graphic cards offer tabbed pages where you can learn more
precise information about your specific graphic card. If specific tab pages are
present, refer to them instead of the Adapter tab.

What is the text editor used for?
The text editor you designate during installation is used for editing text files
such as PGP and CUS dictionary files while you are running your product.

What is the difference between a stand-alone license and a
network license?

Stand-alone licensed products are registered and activated to an individual
workstation. While the software can be installed on multiple systems in your
facility, the license only allows one system to be operational. If you need to
run more systems, you need to purchase more stand-alone licensed products,
or consider converting to network licenses.

Network licensed products rely on the Network License Manager to keep track
of software licenses. The software can be installed and run on multiple systems,
up to the maximum number of licenses you’ve purchased. The Network License
Manager “checks out” licenses until they are all in use. No further systems
can run the program until a license is “checked in.” If you need to run more
systems, you can purchase additional licenses for the Network License Manager
to maintain.
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What is the benefit of using a network licensed version of the
software?

Network licensed products are recommended for large drafting/design facilities,
classrooms, and lab environments. The main advantage is that you can install
products on more systems than the number of licenses you have purchased
(for example, purchasing 25 licenses but installing on 40 workstations). At
any one time, products will run on the maximum number of systems for
which you have licenses. This means you get a true floating license. If software
needs to be run on more systems, additional licenses can be purchased.

How do I access my documentation?
Documentation is available on the product media or as a web-based Help file.
The complete Help system is installed during the product installation process.
During the installation process, you can access specific installation and
licensing documentation by clicking the Read the Documentation or
Documentation links in the wizards.

What is SAMreport-Lite?
SAMreport-Lite is a report generator that helps you monitor the usage of
applications that use FLEXnet. SAMreport-Lite complements FLEXnet by
providing a graphical user interface (GUI) from which to run usage reports.
SAMreport-Lite can help you make better decisions about your software assets.
For more information, see the SAMreport-Lite User’s Guide.

Deployment Issues
This section outlines common issues and their solutions with regards to
software deployments.

Is there a checklist I can refer to when performing a deployment?
Maya Installation contains a checklist that describes preliminary actions of
the deployment process. See Prepare for a Network Deployment on page 33.
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Where should deployments be located?
Shared folders are required for both network license and multi-seat stand-alone
methods of installation. The shared folder (network share) is created before you
run the installation wizard and is where product deployments are stored.

Shared folders are required for multi-seat stand-alone methods of installation.
The shared folder (network share) is created before you run the installation
wizard and is where product deployments are stored.

It is recommended that you name the network share folder Deployments on
the desktop of the system where you want deployments stored. You can then
add subfolders inside the shared Deployments folder that clearly convey the
names of products you plan to deploy. For example, any subfolders that are
placed inside a shared folder are automatically shared.

TIP You must have Full Control permissions set for your shared folder when you
are creating your deployment images. Read permissions are necessary to access
the network share and administrative permissions on the workstation where the
program is deployed.

What are RSS feeds and how do they benefit my installation?
An RSS feed is a live link you initiate by subscribing to someone’s website.
Once subscribed, the primary benefit is a constantly updating stream of content
that is delivered to your system in the form of summarized articles, forum
threads, blog posts, and so on. RSS stands for Rich Site Summary (or Really
Simple Syndication).

Networking Issues
This section outlines common issues and their solutions with regards to
performing a network installation or configuring your network license server(s).

Where do I find my server name?
When installing a network licensed product, you must specify the name of
the server that will run the Network License Manager. If you don’t know the
server name, you can quickly find it by opening a Windows command prompt
on the system that will be the Network License Manager. At the prompt, enter
ipconfig /all and note the Host Name entry.
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What is an administrative image (MSI) file?
An administrative image is a collection of shared file resources created during
the deployment process and is used by deployments to install the program to
networked workstations. Service packs (patches) can be applied to an
administrative image when you create the deployment. A .msi file is a Microsoft
Installer file.

What is the impact of selecting all products for the
administrative image, and can I add products later?

If you elect to include all products in your deployment, the administrative
image will be larger. You should select all products only when you create
multiple deployments from this image and prefer not to use the installation
disc. If there are products you rarely or never use, and you do not expect to
create additional deployments, you should only select a subset of products.

You can still create a deployment at a later date, and include additional
products, but you need to create a new administrative image. You need the
installation disc to do so.

Uninstall and Maintenance Issues
This section outlines common issues and their solutions with regards to adding
and removing features, reinstalling or repairing your installation, and
uninstalling products.

When should I reinstall the product instead of a repair?
You should reinstall your product if you accidentally delete or alter files that
are required by the program. Missing or altered files adversely affect the
performance of your product and cause error messages when you try to execute
a command or find a file.

If an attempt to repair an installation fails, reinstalling is the next best option.
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Do I need my original disc(s) to reinstall my product?
When performing a reinstall of the product, you are prompted to load your
original disc(s). Installation data is cached locally on your drive and that data
is reused when reinstalling.

When I uninstall my software, what files are left on my system?
If you uninstall the product, some files remain on your system such as files
you created or edited (drawings or custom menus).

Your license file also stays on your workstation when you uninstall your
product. If you reinstall on the same workstation, the license information
remains valid and you do not have to reactivate the product.
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Glossary of Installation
Terms

activate Part of the Autodesk software registration process, it allows you to run a product in
compliance with the product's end-user license agreement.

Active Directory A directory service from Microsoft that is part of Windows 2000 and Windows
2003 Server that manages the identities and relationships that make up network environments.

administrative image A collection of shared file resources created by the deployment wizard
and used by deployments to install the program to network workstations.

advertising A pull technology that notifies users of an updated software product that is
available for installation. Users typically double-click a shortcut (or do a similar operation)
to complete the installation of the advertised product.

deploy The process of installing an Autodesk product to one or more computers on a network.

deployment A link to a unique MST (Microsoft Transform) file that serves as a basis for an
installation. Using the deployment wizard, administrators can create multiple deployments
that result in different types of installations for users.

directory service A network service that identifies all resources on a network and makes them
accessible to users and applications. Resources include email addresses, computers, and
peripheral devices such as printers. Ideally, the directory service should make the physical
network topology and protocols transparent so that a user on a network can access any resource
without knowing where or how it is physically connected. Virtually all directory services are
based on the X.500 ITU standard.

group policy Microsoft server technology that provides a way to do push installations and
advertising-based installations using standard Microsoft 2000 Server administration
components.

installation image A deployment that consists of an MSI file, any associated transforms,
additional user-specified custom files, and profile and registry settings.
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language pack A set of installed files that enable the user to work in the application in the
language specified by the Language Pack.

language family A set of languages (core product, plus language packs) that are distributed
together, typically based on a geographic grouping.

License Transfer utility Allows you to use an Autodesk product on more than one computer
without purchasing a separate license for each computer.

MSI Microsoft installer that supports a variety of parameters that can be scripted.

MSP Microsoft patch file (see patch).

MST Microsoft transform file. Modifies the components installed by the MSI file. For example,
the deployment wizard creates an MST file with the settings that you specify. The deployment
created by the deployment wizard uses the MST file in conjunction with the MSI file and
MSIEXEC to install the program on local workstations.

multi-seat stand-alone installation A type of installation where multiple stand-alone seats
of the program are installed using a single serial number.

network license installation A type of installation where you install the program to
workstations with the files and registry entries that allow the program to communicate with
the Network License Manager.

partial profile A profile that contains partial registry information corresponding to a subset
of the options available from the Files tab of the Options dialog box.

patch A software update to an application.

power user A user with rights to access and write to the Program Files folder and the
HKEY_Local_Machine folder of the registry.

pull technology An installation technology that requires user interaction to complete the
installation.

push technology An installation technology that installs files to a remote desktop without
any user interaction.

scripting The process of using scripting languages such as VB Script to facilitate the
deployment of software packages.

service pack Autodesk terminology for an application patch.

silent mode An installation that proceeds without any explicit user input. No dialog boxes
are presented that require interaction from the user.
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Stand-Alone Licensing
Guide

Stand-alone Licensing
A stand-alone license allows you to run an Autodesk® product on a single
workstation.

Introduction
Stand-alone licensing allows you to use your Autodesk product in trial mode
for a given number of days from the first time you launch the product. The
number of days that a trial mode is active differs between Autodesk products.
You can activate your license at any time before the trial period expires.

When you activate your product, you receive an activation code. If you activate
online, your activation code is automatically retrieved from Autodesk and the
product starts. Activations are also available through email, fax, phone, or the
Autodesk website.

NOTE If you are installing and using an Autodesk product on both operating systems
of a dual-boot operating system, you must obtain a separate activation code for
each operating system.

The license file stays on your workstation when you uninstall your product. If
you reinstall your Autodesk product on the same workstation, the license
information is still valid. You do not have to reactivate the product.
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Multi-Seat Stand-Alone License
A multi-seat stand-alone license allows you to install, register, and activate an
Autodesk product on several workstations using a single serial number.
Multi-seat licenses can be purchased through your Authorized Autodesk
Reseller.

The Create Deployment feature in the provided installer simplifies deployment
by creating a server image that you can access to install the software on your
workstation. The software activates automatically when it is started for the
first time and if an Internet connection is available.

NOTE To avoid activation failures, it is recommended that you use the provided
installer to create the deployment server image.

For more information about multi-seat stand-alone install, see your product’s
installation documentation.

Activate Your Product
You can activate your Autodesk product either on startup or while you are
running the product. If you cannot activate online, offline activation is
available.

Manage your Stand-Alone License

Check Product Information
You can view detailed information about your Autodesk product and your
product license (such as the license usage type and the license behavior), and
then save this information as a text file.

License usage types

NOTE All license types are available as stand-alone and network except for the
Student Portfolio license, which is available as stand-alone only.

Commercial A license for a product that was purchased commercially.

Not for Resale A license for a product that is not sold commercially.
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Educational (EDU)/Institution A license designed specifically for educational
institutions.

Student Portfolio A license for students who are using an Autodesk product
as part of their curriculum.

License behaviors
Trial A license that allows individuals to try the product in trial mode for a
specified number of days. The trial period starts the first time you launch your
product. When the trial period expires, the product must be registered and
activated to continue use.

Permanent Allows permanent use of an Autodesk product.

Term Extendable Allows access to an Autodesk product for a limited time.
The term can be extended at any time.

Term Non-Extendable Allows access to an Autodesk product for a limited
time. The term cannot be extended.

View Product Information

To view product information

1 Launch Maya.

2 Select Help > About Maya from the main menu bar.

3 In the About Autodesk Maya window, click Product License Information.

4 In the Product License Information dialog box that appears, view details
about your product and the product license.

NOTE Only basic license borrowing for Maya is supported through the Borrow
License button in this dialog box. For more information, see Borrow a Maya
license with sub-features on page 121.

5 In the Product License Information dialog box, click Close.

Save License Information as a Text File
You can save your product license information as a text file.
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To save license information as a text file

1 Launch Maya.

2 Select Help > About Maya from the main menu bar.

3 In the About Autodesk Maya window, click Product License Information.

4 In the Product License Information dialog box, click Save As.

5 In the Save As dialog box, name the file, choose a location where you
want to save the file, and then click Save.

6 In the Product License Information dialog box, click Close.

Update Your Serial Number
If you installed your product with the trial serial number (000-00000000), you
can update that trial serial number with a valid serial number. Your valid serial
number is located on the outside of the product packaging or in the Autodesk
Upgrade and Licensing Information email you received if you downloaded your
product.

NOTE If you have lost your serial number, contact the Autodesk Business Center
(ABC) at 800-538-6401 for assistance.

When you register and activate your product, you are asked for the product
serial number, which is automatically entered upon completion of the
activation process.

If you have a multi-product bundle of software that uses a single serial number,
only the first product you register and activate displays the updated serial
number. For other products to display the serial number, you must update it
from the Help menu.

NOTE For the updated serial number to display, you must be logged into the
system with Administrator rights.

To update your serial number

1 Launch Maya.

2 Select Help > About Maya from the main menu bar.

3 In the About Autodesk Maya dialog box that appears, click Product License
Information.
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4 In the Product License Information dialog box, click Update.

5 In the Update the Serial Number dialog box, enter your product serial
number.

The serial number is located on the outside of the product packaging or
in the Autodesk Upgrade and Licensing Information email you received if you
downloaded your product.

NOTE If you have lost your serial number, contact the Autodesk Business
Center (ABC) at 800-538-6401 for assistance.

6 Click OK. You can now see the updated serial number.

Transfer your Stand-alone License

About the License Transfer Utility
The License Transfer Utility transfers a product license online from one
computer to another, and ensures that the product works only on the computer
that contains the license. The License Transfer Utility is a custom stand-alone
installation option. During installation, a shortcut is created. A shortcut is
installed once per product, per workstation.

You may want to transfer a license to a computer temporarily (if you want to
use an Autodesk product on your laptop, for example) or permanently (if the
computer where you originally activated your Autodesk product is being
replaced). You can leave the license on the secondary computer indefinitely,
or you can move the license between computers as needed.

License transfers rely on the product’s serial number. Before an Autodesk
product can be exported, it must be activated with the serial number and
product key. During license import, a previously activated and exported license
is imported to a product or product suite installed with the same serial number.
The activation is transferred to the import computer, completing the license
transfer.

NOTE The number of concurrent exports you can have, is equal to the number
of seats you own. For example, if you own one seat you can have one export in
progress at a time. You cannot complete another export until the one in progress
has been imported. Similarly, if you have five seats, you can have up to five
concurrent exports in progress at one time.
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NOTE When you upgrade your Autodesk product (non-subscription), you can no
longer perform online license transfers of the previous license.

NOTE Although the License Transfer Utility allows you to transfer your product
license between computers, your license agreement may not allow the installation
of an Autodesk product on more than one computer. Read your license agreement
to find out whether your product license permits the use of the License Transfer
Utility.

To transfer a license you must have an Internet connection, have an Autodesk
product installed on both computers, and perform an online export and import
of the license.

Install the Autodesk Product
Before you can use the License Transfer Utility to transfer licenses, you must
have an Autodesk product installed on all computers involved in the transfer.

To install the Autodesk product

1 Install and activate the Autodesk product on a computer.

See your product's installation instructions for complete details.

2 Install the Autodesk product on any other computer that will be using
the License Transfer Utility. You do not have to register or activate the
product on this computer.

See your product's installation instructions for complete details.

Export a License
A license is exported when the License Transfer Utility moves a product license
from a computer to the online Autodesk server.

The license can be exported as public or private. Exporting a license as public
means that you are not reserving the license and anyone using the same serial
number and their own user ID and password can import that license. Exporting
a license as private means that you are reserving that license for yourself and
the license can only be imported with the same serial number, your user ID,
and your password.

NOTE An Internet connection is required to export a license.
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To export a license

1 On the computer where you want to export the license, do the following:

■ (Windows XP/Windows 7/Windows Vista) Click Start  ➤  All Programs
 ➤  Autodesk  ➤ [Autodesk Product]  ➤  License Transfer Utility.

■ (Mac OS X) Navigate to /Applications/Autodesk/maya2011/Licensing/
and double-click the License Transfer Utility application.

■ (Linux) Open a shell and run the following command, where
<productKey> is your product key:
/opt/Autodesk/Adlm/R1/bin/LTU <productKey> 2011.0.0.F -d "SA"

The License Transfer Utility displays the Autodesk product name and
serial number.

2 In the License Transfer Utility, click Sign In.

3 On the Log In page, enter your Autodesk user ID and password and click
Log In.

4 On the License Export page, confirm the export information.

5 If you want to make the license available as a public import, click Make
the license available as a public import.

6 Click Export.

7 On the License Export Confirmation page, click Finish.

Import a License
A license is imported when the License Transfer Utility moves a previously
exported product license from the online Autodesk server to a computer.

When you have exported a product license from a computer, you complete
the license transfer process by importing that license onto a computer. A
license is imported when the License Transfer Utility creates an active license
on a computer, allowing your Autodesk product to run on this computer.

When you use the License Transfer Utility to import a license to a computer,
you are not activating the product on the computer; you are simply transferring
your activation to this machine.

NOTE An Internet connection is required to import a license.
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To import a license

1 On the computer where you want to import the license, do the following:

■ (Windows XP/Windows 7/Windows Vista) Click Start  ➤  All Programs
 ➤  Autodesk  ➤ [Autodesk Product]  ➤  License Transfer Utility.

■ (Mac OS X) Navigate to /Applications/Autodesk/maya2011/Licensing/
and double-click the License Transfer Utility application.

■ (Linux) Open a shell and run the following command, where
<productKey> is your product key:
/opt/Autodesk/Adlm/R1/bin/LTU <productKey> 2011.0.0.F -d "SA"

The License Transfer Utility displays the Autodesk product name and
serial number.

2 In the License Transfer Utility, click Sign In.

3 On the Log In page, enter your Autodesk user ID and password and click
Log In.

4 On the License Import Confirmation page, click Finish.

The license is now imported to the computer and you can run your
Autodesk product on this computer. If you want to transfer the license
to another computer, repeat the export and import procedures.

To import a license to replace a trial license

1 On the computer where you want to import the license, do the following:

■ (Windows XP/Windows 7/Windows Vista) Click Start  ➤  All Programs
 ➤  Autodesk  ➤ [Autodesk Product]  ➤  License Transfer Utility.

■ (Mac OS X) Navigate to /Applications/Autodesk/maya2011/Licensing/
and double-click the License Transfer Utility application.

■ (Linux) Open a shell and run the following command, where
<productKey> is your product key:
/opt/Autodesk/Adlm/R1/bin/LTU <productKey> 2011.0.0.F -d "SA"

The License Transfer Utility displays the Update the Serial Number and
Product Key options.

2 Enter the serial number and product key to update your Autodesk product
and click Update.

The License Transfer Utility displays the updated serial number.
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3 In the License Transfer Utility, click Sign In.

4 On the Log In page, enter your Autodesk user ID and password and click
Log In.

5 On the License Import Confirmation page, click Finish.

The license is now imported to the computer and you can run your
Autodesk product on this computer. If you want to transfer the license
to another computer, repeat the export and import procedures.

Troubleshoot a Stand-alone License Error

Hardware Changes
If you replace or reconfigure hardware on the computer where your Autodesk
product license resides, the stand-alone license might fail. You will not be able
to use your product.

To prevent damage to your product license, use the License Transfer Utility
to export your license file. After you make the hardware change, you can
import the license file back. For instructions about using the License Transfer
Utility, see Transfer Your Stand-Alone License.

NOTE If you get a license error when you change your hardware, you may have
to reactivate your license. See Activate Your Product on page 68.

Reinstalling an Operating System
If you reinstall your operating system on the computer where your Autodesk
license resides, the license might fail. You will not be able to use your product.

To resolve a license error in this case, you must reactivate your product. See
Activate Your Product on page 68.

To prevent a license error when you reinstall an operating system

NOTE If using Norton Ghost™  or another image utility, do not include the Master
Boot Record.
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1 Locate one of the following folders and make a backup copy:

■ (Windows XP) C:\Documents And Settings\All Users\Application
Data\FLEXnet

■ (Windows 7/Windows Vista) C:\ProgramData\FLEXnet

2 Reinstall the operating system and reinstall the Autodesk product.

3 Paste the license folder to the same location from which you originally
copied the folder in step 1.

You can now run your Autodesk product.

Changing the System Date and Time
Your product license allows for time changes to the system clock within two
days of the current time. If you set your system clock back more than two
days, the next time you start your product, you will receive a message that
gives you the option of correcting the system clock. If you do not correct the
system clock, you receive a license error.

To prevent a license error due to a change in system date and time

■ Make sure that your computer's system date and time are accurate when
you install and activate your Autodesk product.

Distributing Software Image to Multiple Computers
You can use the Deployment Wizard’s Stand-alone option to create a software
installation image on your server. You can distribute this image by making it
available on your computer network. During creation of this image, you are
prompted for registration information, which is stored with the image and
deployed to all installations.

Additionally, you can manually distribute the software using the installation
CD that comes with your Autodesk product. However, if your computers do
not have an Internet connection, make sure the registration data for each
computer matches exactly. Inconsistent registration data can cause activation
failures.
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To prevent a license error when distributing software image to multiple
computers

■ The distribution of applications using “ghosting” is not recommended,
and can result in incomplete installations and activation problems.

Stand-alone Licensing FAQs

How do I switch my license from stand-alone to network or
network to stand-alone?

If you have purchased stand-alone and network licenses and you want to
switch which license Maya is using, there are two main methods to change
the license type.

■ Uninstall and re-install Maya, changing the type of license you specify
during the install.

■ Edit the MAYA_LICENSE_METHOD environment variable in your
license.env file.
If you have added the MAYA_LICENSE_METHOD variable to your system
environment variables or to a Maya.env file, you must also update the
license type in those locations.

To edit the MAYA_LICENSE_METHOD environment variable

1 Locate the license.env file in the following location:

■ (Windows) C:\Program Files\Autodesk\Maya2011\bin

■ (Linux) /usr/autodesk/maya2011-x64/bin

■ (Mac OS X) In the Maya installation directory (by default
/Applications/Autodesk/maya2011/), right-click the Maya application
and select Show Package Contents. Locate the license.env file in the
Contents directory.

2 Edit the MAYA_LICENSE_METHOD variable to indicate the type of license
you want, for example:

MAYA_LICENSE_METHOD=standalone

to set Maya to use a stand-alone license, or
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MAYA_LICENSE_METHOD=network

to set Maya to use a network license.

If you are switching from a stand-alone to a network license, continue
with the following steps to set your license server name.

3 Navigate to the following directory to locate and open the LICPATH.LIC
file.

■ (Windows) C:\Program Files\Autodesk\Maya2011

■ (Mac OS X and Linux) /var/flexlm/

4 Edit the line SERVER <servername> where <servername> is your license
server name.

If you do not find the LICPATH.LIC file in this location, you can create a
license file by saving a text file with the extension .lic, and including the
following lines:

SERVER <servername> 0

USE_SERVER

IMPORTANT If you have added the MAYA_LICENSE_METHOD variable to your
system environment variables or to a Maya.env file, you must also update the
license type in those locations.

To locate the Maya.env file

■ (Windows) C:\Documents and Settings\user\My Documents\maya

■ (Mac OS X)
/Users/username/Library/Preferences/Autodesk/maya/version

■ (Linux) /home/<user>/maya
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Network Licensing Guide

Network Licensing
A network license lets you run an Autodesk product on a network. Network
licenses can be purchased through your Authorized Autodesk Reseller.

Setting up network licenses for an Autodesk product requires careful planning
and execution. This section gives you instructions about how to set up a network
licensed environment, and assumes that you are familiar with the terminology
and processes required to set up an Autodesk product to run on a network.

Plan Your Network Licensing
This section contains information that you need to know before you set up a
network license server. The section includes information about supported license
server models, license operation and availability, network license file definitions
and parameters, license file examples, license types and behaviors, and the
license server heartbeat signal.

System Requirements for the Network License Manager

System Requirements for the Network License Manager
(Windows)

Make sure that your network license server meets the minimum recommended
requirements. See the following tables for hardware and software requirements.
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NOTE The Network License Manager supports Ethernet network configurations
only.

Hardware and software requirements for the network license server (Windows)

RequirementHardware/Software

Windows® 7® 32-bitOperating System

Windows 7 64-bit

■ Windows 7 Starter (32-bit)

■ Windows 7 Home Basic (32-bit)

■ Windows 7 Home Premium

■ Windows 7 Professional

■ Windows 7 Ultimate

■ Windows 7 Enterprise

Windows Vista 32-bit SP2 or later
Windows Vista 64-bit SP2 or later

■ Windows Vista Enterprise

■ Windows Vista Business

■ Windows Vista Ultimate

■ Windows Vista Home Premium and Basic (32-bit)

■ Windows Vista Home Premium (64-bit)

Windows XP 32-bit SP2 or later
Windows XP 64-bit SP2 or later

■ Windows XP Home

■ Windows XP Professional

Windows Server 32-bit SP1 or later
Windows Server 64-bit SP1 or later

■ Windows 2008 Server R2

■ Windows 2008 Server

■ Windows 2003 Server R2

■ Windows 2003 Server
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Hardware and software requirements for the network license server (Windows)

RequirementHardware/Software

Intel® Pentium® III or higherComputer/processor

450 Mhz (minimum)

Compatible with existing Ethernet network infrastructureNetwork interface card

NOTE The Network License Manager supports multiple network interface
cards, but at least one must be an Ethernet card.

TCP/IPCommunication protocol

NOTE The Network License Manager uses TCP packet types.

Internet Explorer® 6Browsers

Internet Explorer 7
Internet Explorer 8

11.7.0.0FLEXnet

Virtual Machine Support (Windows)

Virtual OSVirtualizerHardware

Vista 64-bit, Vista 32-bit, Windows XP
32-bit, Windows 7 32-bit (Home

Windows 2008 or Windows
2003R2 servers running on VM-

Intel PC 64

Premium, Professional, Ultimate, andware® ESX3.5 Update 3 (License
Manager Only) Enterprise), Windows 7 64-bit, Win-

dows Server 32-bit, Windows Server
64-bit

System Requirements for the Network License Manager (Mac
OS X)

Make sure that your network license server meets the minimum recommended
requirements. See the following tables for hardware and software requirements.
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NOTE The Network License Manager supports Ethernet network configurations
only.

Hardware and software requirements for the network license server (Mac OS X)

RequirementHardware/Software

Mac OS® X version 10.6 and laterOperating system

Intel MacComputer/processor

Compatible with existing Ethernet network infrastructureNetwork interface card

NOTE The Network License Manager supports multiple network interface
cards, but at least one must be an Ethernet card.

TCP/IPCommunication protocol

NOTE The Network License Manager uses TCP packet types

Safari 4.0Browsers

11.7.0.0FLEXnet

System Requirements for the Network License Manager (Linux)
Make sure that your network license server meets the minimum recommended
requirements. See the following tables for hardware and software requirements.

NOTE The Network License Manager supports Ethernet network configurations
only.

Hardware and software requirements for the network license server (Linux)

RequirementHardware/Software

Linux® 64-bitOperating system

Red Hat® Enterprise Linux 5.0 WS (U4)

Intel Pentium 3 or higherComputer/processor
450 Mhz (minimum)

Compatible with existing Ethernet network infrastructureNetwork interface card
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Hardware and software requirements for the network license server (Linux)

RequirementHardware/Software

NOTE The Network License Manager supports multiple network interface
cards, but at least one must be an Ethernet card.

TCP/IPCommunication protocol

NOTE The Network License Manager uses TCP packet types

11.7.0.0FLEXnet

Plan Your License Server Configuration
You must decide which license server model to use for managing your Autodesk
product licenses on a server. Autodesk supports the following network license
server models:

■ Single license server model

■ Distributed license server model

■ Redundant license server model

Single License Server Model
In the single license server model, the Network License Manager is installed
on a single server, so license management and activity is restricted to this
server. A single license file represents the total number of licenses available
on the server.

Advantages of the Single License Server Model

■ Because all license management takes place on a single server, you have
just one point of administration and one point of failure.

■ Of the three license server models, this configuration requires the least
amount of maintenance.
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Disadvantage of the Single License Server Model

■ If the single license server fails, the Autodesk product cannot run until the
server is back online.

Distributed License Server Model
In the distributed license server model, licenses are distributed across more
than one server. A unique license file is required for each server. To create a
distributed license server, you must run the Network License Manager on each
server that is part of the distributed server pool.

Advantages of the Distributed License Server Model

■ Servers can be distributed across a wide area network (WAN); they do not
need to exist on the same subnet.

■ If one server in the distributed server pool fails, the licenses on the
remaining servers are still available.

■ If you need to replace a server in the distributed server pool, you do not
need to rebuild the entire pool.

■ Server replacement is easier than in a redundant server pool, where you
must reactivate the entire pool.

Disadvantage of the Distributed License Server Model

■ If a server in the distributed server pool fails, the licenses on that server
are unavailable.

Redundant License Server Model
In the redundant license server model, you use three servers to authenticate
a single license file. One server acts as the master, while the other two provide
backup if the master server fails. With this configuration, licenses continue
to be monitored and issued as long as at least two servers are still functional.
The license file on all three servers is the same. You must install the Network
License Manager on each server.

In the redundant license server model, all servers must reside on the same
subnet and have consistent network communications. (Slow, erratic, or dial-up
connections are not supported.)
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Advantage of the Redundant License Server Model

■ If one of the three servers fails, all licenses that are managed in the server
pool are still available.

Disadvantages of the Redundant License Server Model

■ If more than one server fails, no licenses are available.

■ All three servers must reside on the same subnet and have reliable network
communications. The redundant server pool does not provide network
fault tolerance.

■ If one of the three servers is replaced, the complete redundant server pool
must be rebuilt.

■ If your Autodesk product supports license borrowing and licenses are
borrowed from a redundant license server pool, you must restart the license
server after you stop the Network License Manager.

Learn About Your License
In this section, you learn about license operation and availability, the license
file, license types and behaviors, and the heartbeat signal.

License Operation and Availability
When you start an Autodesk product, the product determines the server from
which it should try to obtain a license. The product then requests a license
through the TCP/IP network protocol to the license server.

If the number of available licenses has not been exceeded on the license server,
the Network License Manager assigns a license to the workstation. A product
session then starts on the workstation, and the number of available licenses
on the license server is reduced by one.

Likewise, when you exit a product, the Network License Manager frees a license
for another user. If you run multiple sessions of an Autodesk product on an
individual workstation, only one license is used. When the last session is
closed, the license is freed.
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The following three processes manage the distribution and availability of
licenses:

■ License manager daemon (lmgrd.exe). Handles the original contact with
the application, and then passes the connection to the vendor daemon.
The lmgrd.exe daemon is used to communicate with the vendor daemon
only; lmgrd.exe does not authenticate or dispense licenses, but rather passes
user requests to the vendor daemon. By using this approach, a single
lmgrd.exe daemon can be used by multiple software vendors to provide
license authentication. The lmgrd.exe daemon starts and restarts the vendor
daemons as needed.

■ Autodesk vendor daemon (adskflex.exe). Tracks the licenses that are checked
out and the workstations that are using them. Each software vendor has
a unique vendor daemon to manage vendor-specific licensing. As its name
implies, the adskflex.exe vendor daemon is specific to Autodesk products.

■ License file. A text file that has vendor-specific license information.

You can run only one Autodesk vendor daemon (adskflex.exe) on your license
server. This means that if you plan to serve licenses for multiple Autodesk
products that were purchased individually (not as part of a suite or bundle)
you must combine the license file contents for the products into one license
file.

For example, if you plan to serve Maya licenses from a machine that is already
serving 3ds max licenses, you must append the contents of your Maya license
file to the 3ds max license file. See Example of a License File for Combined
Autodesk Product Versions on page 91 for more information.

TIP You can use the following commands to query the status of your license server
and determine how many licenses you have in total, how many are in use, and to
verify that your license server is up and running:

■ (Windows) lmutil lmstat -a -c <license file> (where <license file>

is your license file name)

■ (Mac OS X)
/usr/local/flexnetserver/lmutil lmstat -a -c /var/flexlm/maya.lic

■ (Linux)
/opt/flexnetserver/lmutil lmstat -a -c /var/flexlm/maya.lic
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License Files
The network license file you receive from Autodesk contains licensing
information required for a network installation. You obtain license file data
when you register your Autodesk product.

The license file contains information about network server nodes and vendor
daemons. It also contains an encrypted digital signature that is created when
Autodesk generates the file.

The license file is located on your license server in the location that you specify
when you save the license file from the RegisterOnce Web page, or using the
license information that Autodesk emails to you.

NOTE If you are already running a network license server for a separate Autodesk
product, such as 3ds max, you must append the contents of your Maya license
file to the contents of the license file for the other Autodesk product. See Example
of a License File for Combined Autodesk Product Versions on page 91.

The following table defines each license file parameter.

Definitions of license file parameters

ExampleDefinitionParameterLine

LABSERVERHost name of the server where the
Network License Manager resides

Host NameSERVER

03D054C0149BEthernet address of the server where
the Network License Manager resides

Host ID

[None]USE_SERVER

adskflex.exeName of the server-side Autodesk
vendor daemon

Vendor DaemonVENDOR

port=2080Network port number reserved and
assigned for use only by Autodesk

Port Number

products running the Autodesk
vendor daemon

SERIES_1Name of feature code groupNamePACKAGE

1.000Internal version number referenceVersion
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Definitions of license file parameters

ExampleDefinitionParameterLine

COMPONENTS=
"526000REVIT_9_OF\

List of feature codes supported in the
package

COMPONENTS

51200ACD_2007_OF\
513001IN-
VBUN_11_OF"

OPTIONS=SUITEOPTIONS

SUPERSEDEReplacement for any existing Incre-
ment line of the same feature code

SUPERSEDE

from any license files on the same li-
cense server that have a date earlier
than the defined Issue Date

SIGN=0 SIGN2=0Encrypted signature used to authen-
ticate the attributes of the license file

SIGN

51200ACD_2007_0FProduct supported by the license fileFeature CodeINCREMENT

permanentAmount of time the licenses are
available

Expiration Date

25Number of licenses supported by the
license file

Number of Licenses

COMMERCIALLicense usage type and license beha-
vior of the product that is supported
by the license file

VENDOR_STRING

BORROW=4320Definition of the license borrowing
period for the licenses defined under
the same increment line.

BORROW

In this example, the maximum peri-
od that licenses can be borrowed is
4320 hours (180 days), unless other-
wise noted (for example, BOR-
ROW=2880 means that licenses can
be borrowed for a maximum of
2880 hours, or 120 days).
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Definitions of license file parameters

ExampleDefinitionParameterLine

License borrowing is disabled when
this parameter is absent in the li-
cense file.

DUP_GROUP=UHDefinition of multiple license re-
quests when the same user and same
host share the same license

DUP_GROUP

15-jul-2006Date that the license file was gener-
ated by Autodesk

ISSUED

123-12345678Serial number of the Autodesk
product

Serial Number

SIGN=6E88EFA8D44CEncrypted signature used to authen-
ticate the attributes of the license file

SIGN

License File Examples

Example of a License File Not Specific to a Product
Here is an example of the contents of a license file and the parameters
associated with each line:

SERVER ServerName HostID

USE_SERVER

VENDOR adskflex port=portnumber

INCREMENT feature_code Adskflex Version ExpDate NumberofLicenses

\

VENDOR_STRING=UsageType:Behavior BORROW=4320 SUPERSEDE \

DUP_GROUP=DupGrp ISSUED=IssueDate SN=SerialNumber SIGN= \
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Example of a License File for a Single or Distributed Server
Here is an example of a completed license file for a single or distributed license
server model:

SERVER XXHP0528 0019bbd68993

USE_SERVER

VENDOR adskflex port=2080

INCREMENT 57600ACD_2009_0F adskflex 1.000 permanent 5 \

VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \

DUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678 SIGN="1393 \

E368 816E D417 C1CD 7DBD 7B90 1354 D6F0 48FE EBB8 9C84 C3AF \

7D79 BEE1 0181 0655 76FF 996C B707 14B5 D4DE A3FE 0B2D 2D36 \

057C A579 7866 26BF 44E2" SIGN2="1280 943B 53A7 9B93 E00B D967

\

D821 BD37 BE6D B78A F074 B223 88AA 242C DD0A 1292 D56F 4108 \

62CD FA35 E365 0736 A011 7833 8B35 7BFF DAD8 34A8 452F 2EB4"

Example of a License File for a Redundant Server
Here is an example of a completed license file for a redundant license server
model:

SERVER CCN12378042 001cc4874b03 27005

SERVER XXHP0528 0019bbd68993 27005

SERVER CCN12378043 001cc4874b10 27005

USE_SERVER

VENDOR adskflex port=2080

INCREMENT 57600ACD_2009_0F adskflex 1.000 permanent 5 \

VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \

DUP_GROUP=UH ISSUED=10-Jan-2008 SN=123-12345678 SIGN="11C4 \

CA79 07FC 7AD0 409A 6E04 6E98 D76C 197C 0416 076C B211 1CDD \

D0AB 698B 16BF 7A0E D4F8 1CFE 2985 644F 64CD CECE 0DDB 5951 \

3262 7C31 13A8 F08F 55B2" SIGN2="19A6 FDA3 2ED5 5301 8675 7B81

\

1B0E 451B 19F1 1A99 C8E9 CBA6 8CB3 6AC3 8B38 1519 13F2 2373 \

82AE 55E5 1A25 4952 4458 F3A2 6F28 D25D 1DC0 E066 209B 0953"

NOTE The redundant server model requires the addition of a port number (the
default is 27005) for each server.
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Example of a License File for Combined Autodesk Product
Versions

You can combine a license file for different releases of the same Autodesk
product or for different Autodesk products, and run all products from one
license server. For example, you can combine a license file for AutoCAD 2009
with license files for Autodesk Maya® 2009 and AutoCAD Map.

If your license server distributes licenses for multiple Autodesk products that
were purchased individually (not part of a suite or bundle), you must combine
the network license information from all products into one license file.

In this example, the content from a license file for AutoCAD 2008 has been
appended to an AutoCAD 2009 license file:

SERVER XXHP0528 0019bbd68993

USE_SERVER

VENDOR adskflex port=2080

INCREMENT 57600ACD_2009_0F adskflex 1.000 permanent 5 \

VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \

DUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678 SIGN="1393 \

E368 816E D417 C1CD 7DBD 7B90 1354 D6F0 48FE EBB8 9C84 C3AF \

7D79 BEE1 0181 0655 76FF 996C B707 14B5 D4DE A3FE 0B2D 2D36 \

057C A579 7866 26BF 44E2" SIGN2="1280 943B 53A7 9B93 E00B D967 \

D821 BD37 BE6D B78A F074 B223 88AA 242C DD0A 1292 D56F 4108 \

62CD FA35 E365 0736 A011 7833 8B35 7BFF DAD8 34A8 452F 2EB4"

INCREMENT 54600ACD_2008_0F adskflex 1.000 permanent 3 \

VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \

DUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678 SIGN="1E6E \

4B61 5712 4766 92A0 6782 9EF4 3F47 56A1 1F38 6DE8 C0C7 90AC \

7289 152E 0EA2 CC0D 3F10 577A 0489 CEB6 10D5 FBCC B552 0C9D \

5966 91A6 59F0 2788 FACE" SIGN2="1DDF 3B9D 3392 71D5 AB08 7E05 \

8497 111E 092F 0E54 8DC2 2BED 17C2 2CC1 981B 0EC2 BC15 8F00 \

C79A ABFD 2136 BABA 2EDF E941 EA53 32C6 597F F805 5A8A 599A"
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For example, the section of license information you need to append from one
file into the other is similar to the following:

INCREMENT 54600ACD_2008_0F adskflex 1.000 permanent 3 \

VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \

DUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678 SIGN="1E6E \

4B61 5712 4766 92A0 6782 9EF4 3F47 56A1 1F38 6DE8 C0C7 90AC \

7289 152E 0EA2 CC0D 3F10 577A 0489 CEB6 10D5 FBCC B552 0C9D \

5966 91A6 59F0 2788 FACE" SIGN2="1DDF 3B9D 3392 71D5 AB08 7E05 \

8497 111E 092F 0E54 8DC2 2BED 17C2 2CC1 981B 0EC2 BC15 8F00 \

C79A ABFD 2136 BABA 2EDF E941 EA53 32C6 597F F805 5A8A 599A"

Package License File Examples
Autodesk offers a package license file option, which allows you use of a set of
products that are packaged and sold together. The package license file contains
a set number of licenses for four different versions of your software. Running
an instance of any one of the versions uses one license in the package. Packaged
license files support prior versioning for subscription users. Package license
files operate under the following guidelines:

■ Package license files come with the current version of the software and
three previous versions of the same product.

■ License files may be combined with license files for different products. For
more information about combining license files, see Example of a Package
License File for Combined Autodesk Product Versions on page 95.

■ Package license files cannot be combined with non-package license files
for product versions contained in the package. For example, you cannot
combine a Autodesk Product 2009 package license file with a regular license
file for Autodesk Product 2008, 2007, or 2006.

■ Both the PACKAGE and INCREMENT sections of the license are required
for licensing to work properly. When you combine license files, be sure to
include both of these sections.

■ License borrowing, option files, and licensing cascading work the same
for package licenses as they do for regular license files.

■ A new license file will supersede an older license file.

The following sections provide package license file examples for single,
distributed, and redundant license servers, and combined Autodesk product
versions.
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Example of a Package License File for a Single or Distributed
Server

Here is an example of a completed license file for a single or distributed license
server model:

SERVER Server1 1a34567c90d2

USE_SERVER

VENDOR adskflex port=2080

PACKAGE SERIES_1 adskflex 1.000 COMPONENTS="54700REVIT_2009_0F \

54600ACD_2009_0F 51300INVBUN_11_0F" OPTIONS=SUITE SUPERSEDE \

ISSUED=09-Jan-2008 SIGN="1707 9EAC CBCB 2405 692E 4A89 \

AA26 30CC 2AC2 D6B3 A61B AB5E 492E 3EBD 0B48 4E75 193A DA82" \

FC45 C009 E360 944A 14BA E99C 9B24 5A1B 4A44 083A BE5F 3827 \

SIGN2="004A FC90 AB47 3F6B 59BC 0E6D 6681 6971 A76A BA52 98E2

\

5671 26B3 0E78 791B 109F 0591 7DC3 F09F 4D8D 4FB7 E341 4A03 \

CD68 1D77 27F8 8555 9CF7 DEDD 9380"

INCREMENT SERIES_1 adskflex 1.000 permanent 100 \

VENDOR_STRING=commercial:permanent BORROW=4320 DUP_GROUP=UH \

SUITE_DUP_GROUP=UHV SN=123-12345678 SIGN="1707 9EAC CBCB \

692E 4A89 FC45 C009 E360 944A 14BA E99C 9B24 5A1B 4A44 BE5F \

3827 AA26 30CC 2AC2 D6B3 A61B AB5E 492E 3EBD 0B48 DA82" \

SIGN2="004A FC90 AB47 3F6B 59BC 0E6D 6681 6971 A76A BA52 \

5671 26B3 0E78 791B 109F 0591 7DC3 F09F 4D8D 4FB7 E341 4A03 \

CD68 1D77 27F8 8555 9CF7 DEDD 9380"
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Example of a Package License File for a Redundant Server
Here is an example of a completed license file for a redundant license server
model:

SERVER 1a34567c90d2 27005

SERVER 2a34567c90d2 27005

SERVER 3a34567c90d2 27005

USE_SERVER

VENDOR adskflex port=2080

PACKAGE 64300ACD_F adskflex 1.000 COMPONENTS="57600ACD_2009_0F \

   54600ACD_2008_0F 51200ACD_2007_0F 48800ACD_2006_0F" \

   OPTIONS=SUITE SUPERSEDE ISSUED=27-May-2008 SIGN="1092 05D8 \

   A206 276B 2C84 EFAD ACA5 C54B 68A4 653E C61F 31DE C8CE B532 \

   CFBB 0006 5388 347B FDD6 A3F4 B361 7FD4 CDE4 4AAC 0D11 B0EF \

4B44 BFD6 3426 97DD" SIGN2="0670 B01A D060 0069 FF25 F1CD D06B

\

314E E7C9 3552 5FFA 4AC7 28A7 C897 F56A 19BB FB1C 754E 6704 \

DEEA AC4E F859 2E9B 64B6 0DD0 9CCE 9556 269F EAC0 2326"

INCREMENT 64300ACD_F adskflex 1.000 permanent 50 \

VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \

DUP_GROUP=UH SUITE_DUP_GROUP=UHV ISSUED=27-May-2008 \

SN=399-99999999 SIGN="1B5B 8D70 4CAD 32E5 9CA2 82E0 5C47 291C

\

35AB 9B9C 5B3E 5067 F61B 4139 1B32 0716 1FD3 5105 A991 B78E \

9D1E 63AB BC23 0D1E B70C 2A05 E1C1 F605 ABB1 2EA8" SIGN2="01D6

\

31F5 2951 4500 E5C8 058F 7490 9789 9EF4 CBED DA27 5F06 6780 \

9033 2018 0C3B E1E0 3580 E60E C2BB B4AB 8D6A 4245 3059 8CA6 \

2EFE DFAE 027F 2ABE 3F2B"
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Example of a Package License File for Combined Autodesk
Product Versions

Here is an example of a completed license file for combined Autodesk product
versions:
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SERVER servername 123456789111

USE_SERVER

VENDOR adskflex port=2080

PACKAGE 64300ACD_F adskflex 1.000 COMPONENTS="57600ACD_2009_0F \

   54600ACD_2008_0F 51200ACD_2007_0F 48800ACD_2006_0F" \

   OPTIONS=SUITE SUPERSEDE ISSUED=25-Jun-2008 SIGN="03EF DE18 \

   8046 0124 4EA4 6953 F82D 3169 7C24 D0DE E58E 8168 FFA3 D891 \

   B43B 08D8 7E7F C6ED CBCC FE2A BB0A 4566 C2AE F1C1 D373 8348 \

   E6E3 884A E398 1C78" SIGN2="07AC D696 8844 D19F AB00 8B75 53A3

\

   2F76 91DF AED0 3231 1506 0E6B ADC6 C3B8 1797 93B5 9756 8C0F \

   8811 56E6 B2BA 0523 FE2E 82B7 1628 076F 173B F37C 7240"

INCREMENT 64300ACD_F adskflex 1.000 permanent 2 \

   VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \

   DUP_GROUP=UH SUITE_DUP_GROUP=UHV ISSUED=25-Jun-2008 \

   SN=399-99999999 SIGN="1CCB E88D B819 8604 06FA 9AEE 42F1 CBEA

\

   37B9 3CFA A0A8 697F 9CB1 8354 6256 05ED 69D4 D2FF D512 6A2E \

   D5DD B722 EF5B 3172 BA95 4625 F8D3 DD24 BB39 6A58" SIGN2="0DFF

\

   FA6F C378 20E0 2622 BE52 B434 F99F 2681 2B93 64F2 CE0C 7F4A \

   7024 B3D1 051A 6920 72BD DE35 8920 E6A1 C8D6 AF23 7BE7 CC91 \

   6916 70B1 9E80 AB07 1644"

PACKAGE 64800INVPRO_F adskflex 1.000 \

COMPONENTS="59600INVPRO_2009_0F \

   55300INVPRO_2008_0F 51400INVPRO_11_0F 49000INVPRO_10_0F" \

   OPTIONS=SUITE SUPERSEDE ISSUED=25-Jun-2008 SIGN="1306 5990 \

   F8A1 56FB 1D8A 9DA7 D6AE 8E9E F6EC 2862 367A 36E2 C5FB E6E1 \

   4AAA 0128 8C2D 95FD 09B2 ABA1 6F98 A0A3 70DE 3220 6835 7E51 \

   3849 9D81 8BDC 9DC1" SIGN2="0021 AA08 F2E7 8AEB 5345 341A 7E42

\

   3001 B8C5 DFC2 6EB8 87C5 C04A AE43 A10F 1DA1 EF8A F0FA 10F5 \

   AC81 1E22 789F A18D 650F 6BBB 563A BDA5 DD1C 82EC 27F6"

INCREMENT 64800INVPRO_F adskflex 1.000 permanent 2 \

   VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \

   DUP_GROUP=UH SUITE_DUP_GROUP=UHV ISSUED=25-Jun-2008 \

   SN=399-99999966 SIGN="0BE4 51F4 570C DC48 5E66 F952 629E EDF0

\

   019C 6FF7 0509 1FF0 D4FB 3B16 1981 073F 31EC A241 8CB3 8782 \

   E655 00C6 E097 D5EF B0D8 67D3 199D 699D 2E09 B16F" SIGN2="1254

\

   3E37 0CE4 F42D B7CD 858C 92FC A963 5274 770F 9354 FE29 E117 \

   205D C632 0C4E AEC0 7501 9D9E FFEB D84D F154 16A1 E120 339A \
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FDBF 3F07 4477 B8B3 5DA4"

License Types and Behaviors
Autodesk supports dynamic product usage and license behaviors. This means
that you can purchase a specific type of behavior with a specific license and
change that license at a later date without having to uninstall and reinstall
the Autodesk product.

NOTE All license types are available as stand-alone and network except for the
Student Portfolio license, which is available as stand-alone only.

License types include the following:

■ Commercial. A license for a product that was purchased commercially.

■ Not for Resale. A license for a product that is not sold commercially. Not
for Resale products are for evaluation or demonstration purposes only and
may not be used for commercial or production use.

■ Educational (EDU)/Institution. A license designed specifically for
educational institutions.

■ Student Portfolio. A license for students who are using an Autodesk product
as part of their curriculum.

License behaviors are as follows:

■ Permanent. Enables permanent use of an Autodesk product.

■ Term Extendable. Enables access to an Autodesk product for a limited time.
The term can be extended at any time.

■ Term Non-Extendable. Enables an Autodesk product for a limited time.
The term cannot be extended.

Heartbeat Signal
When an Autodesk product is running, it communicates with the license
server at regular intervals using a communication method known as the
“heartbeat” signal. If the heartbeat signal is lost, the server tries to reconnect.
If the server cannot reconnect, the user receives a license error.

Learn About Your License | 97



If the product stops working because it has lost a connection to the server,
you must shut down the product, and then restart it. If the problem causing
the original loss of the heartbeat signal is resolved and there are available
licenses on the server, the program can be restarted.

Network License Manager

Install the Network License Manager
The Network License Manager is used to configure and manage license servers.
It includes the lmgrd, adskflex, and lmutil tools that you need to set up your
license server.

(Windows) When creating a deployment, the Installation wizard prompts you
for information about the license manager, such as license server model and
server name.

If an earlier version of the Network License Manager is already installed on
the computer, you should upgrade by installing the Autodesk Network License
Manager into the folder where the older version was located.

Install the Network License Manager (Windows)
You can install the Network License Manager before or after you use the
Installation wizard. The order in which you install the network applications
does not matter, as long as you install everything you need and you provide
consistent license server information across the network applications.

To install your Network License Manager

1 In the Autodesk Installation wizard, click Install Tools and Utilities.

2 On the Select the Products to Install page, select Autodesk Network License
Manager and click Next.

3 Review the Autodesk software license agreement for your country or
region. You must accept this agreement to proceed with the installation.
Choose your country or region, click I Accept, and then click Next.

NOTE If you do not agree to the terms of the license and want to terminate
the installation, click Cancel.
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4 On the Begin Installation page, review your product selection and the
current settings. If you do not want to change anything, click Install. If
you want to change the install type or installation path, click Configure.

5 On the Select the Installation Location page, accept the default installation
path (C:\Program Files\Autodesk Network License Manager) or Browse to
specify a different path. If you enter a path that does not exist, a new
folder is created using the name and location you provide. Click Next.

WARNING Do not install the Network License Manager on a remote drive.
When you install the Network License Manager files, you must provide a path
to a local drive. You must specify the drive letter; the universal naming
convention (UNC) is not permitted.

6 On the Configuration Complete page, click Configuration Complete to
return to the confirmation page.

7 On the Begin Installation page, click Install.

8 When the Installation Complete page displays, click Finish.

Install the Network License Manager (Mac OS X)

To install the Network License Manager

1 Navigate to the NetworkLicenseManager folder on your Maya DVD, or
in the package you downloaded.

2 Do one of the following:

■ (DVD) Double-click the Network License Manager package icon.

■ (Download) Double-click the Network License Manager .dmg, then
double-click the Network License Manager package icon.

The Install Autodesk NLM wizard appears.

3 Click Continue to begin the installation, then follow the instructions in
the installer to install the Network License Manager tools.

4 Click Close when you see the Install Succeeded message.

By default, the Network License Manager tools are installed in the
following directory: /usr/local/flexnetserver. In addition, scripts to
help set up your license server are installed in the following directory:
/Library/StartUpItems/adsknlm.
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Install the Network License Manager (Linux)

To install the Network License Manager

1 Open a shell as a super user.

2 Navigate to the NetworkLicenseManager directory on your Maya DVD,
or extract the Network License Manager package from the compressed
file that you downloaded.

3 To install the Network License Manager, enter the following command:

rpm -ivh adlmflexnetserver-#.rpm

where # is the package number.

Obtain a License Through autodesk.com
You can register and activate your network license by going to
https://registeronce.autodesk.com and following the on-screen instructions.

Obtain the Server Host Name and Host ID Manually
Autodesk uses the server host name, host ID, and product serial number to
generate a license file.

To obtain the information manually, you can use the command prompt or
you can run the lmtools.exe utility. If you use lmtools.exe, do not run it on a
remote workstation.

To obtain the host name and ID using the Windows command prompt

1 Do one of the following:

■ (Windows XP) Click Start > Programs > Accessories > Command
Prompt.

■ (Windows Vista) Click Start > All Programs > Accessories > Command
Prompt.

2 In the Windows command prompt, enter the following command, then
press Enter:

ipconfig /all

3 Locate the Host Name line, and write down the host name.
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4 Locate the Physical Address line. Write down the physical address without
the dashes. This is your twelve-character host ID.

NOTE If your server has more than one network adapter, select the one that
corresponds to a physical network adapter. To determine which adapters are
physical: in the Windows command prompt, enter ipconfig /all, and then
view the Description field above each physical address. If there is more than
one physical network adapter, it does not matter which one you use. Devices
such as VPN adapters, PPP adapters, and modems are not valid.

5 Close the Windows command prompt.

To obtain the host name and ID using lmtools.exe

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

1 Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

2 In the LMTOOLS program, click the Systems Settings tab.

3 On the Systems Settings tab, locate the Computer/Hostname box. Copy
the host name and paste the information into a text editor.

4 Locate the Ethernet Address box. The Ethernet address is the host ID. It
consists of twelve characters. Write down the information. If your Ethernet
address is more than twelve characters, write down the first twelve
characters only.

NOTE If your server has more than one Ethernet adapter, select one that
corresponds to a physical network adapter.

5 Close lmtools.exe.

To obtain the host name and ID using the Mac OS X or Linux terminal window

1 Launch a Terminal window.

2 Go to the directory where lmutil is installed.

3 Retrieve the host name by entering the following in Terminal:

<prompt>./lmutil lmhostid -hostname

The host name is displayed.
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4 Retrieve the host ID by entering the following in Terminal:

<prompt>./lmutil lmhostid

The twelve-character host ID is displayed.

5 Close the Terminal Window.

Configure a License Server

Configure a License Server (Windows)
You configure a license server so that you can manage your Autodesk product
licenses. Configure the license server with the lmtools.exe utility.

To configure your license server

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

1 Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

2 In the LMTOOLS program, on the Service/License File tab, make sure the
Configure Using Services option is active.

3 Click the Config Services tab.

4 In the Service Name list, select the service name you want to use to
manage licenses.

By default, the service name is Flexlm Service 1. If FLEXnet® is managing
other software on your computer in addition to Autodesk, you can change
the service name to avoid confusion. For example, you can rename Flexlm
Service 1 to Autodesk Server1.

NOTE If you have more than one software vendor using FLEXnet for license
management, the Service Name list contains more than one option. Make
sure that only one Autodesk service is listed.

5 In the Path to Lmgrd.exe File field, enter the path to the Network License
Manager daemon (lmgrd.exe), or click Browse to locate the file.

By default, this daemon is installed in the C:\Program Files\Autodesk
Network License Manager folder.
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6 In the Path to the License File box, enter the path to your license file, or
click Browse to locate the file.

This is the path to the license file obtained through autodesk.com or the
location where you placed the license file if you obtained it offline.

7 In the Path to the Debug Log File box, enter a path to create a debug log,
or click Browse to locate an existing log file.

It is recommended that you save to the C:\Program Files\Autodesk Network
License Manager folder. The log file must have a .log file extension. For
new log files, you must enter the .log extension manually.

8 To run lmgrd.exe as a service, select Use Services.

9 To start lmgrd.exe automatically when the system starts, select Start Server
at Power Up.

10 Click Save Service to save the new configuration under the service name
you selected in step 4. Click Yes when prompted if you would like to save
the settings to the service.

11 Click the Start/Stop/Reread tab and do one of the following:

■ If a service has not yet been defined for Autodesk, click Start Server
to start the license server.

■ If a service for Autodesk is already defined and running, click ReRead
License File to refresh the Network License Manager with any changes
made to the license file or Options file.

The license server starts running and is ready to respond to client requests.

12 Close lmtools.exe.

NOTE Before performing any system maintenance on your license server,
see Stop and Restart the License Server on page 109.

Configure a License Server (Mac OS X)
You configure a license server so that you can manage the Maya licenses you
received using the Autodesk Register Once Web page. You configure the license
server using the LMTOOLS utility.
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Before configuring your license server, ensure that:

■ You have installed the Network License Manager, which contains the
following files: lmgrd, adskflex, and lmutil. For Mac OS X, this installer
also includes important scripts that help you set up your license server.
(See Install the Network License Manager (Mac OS X) on page 99.)

■ You have received the network license file from Autodesk that contains
the product licenses; for example, productlicense.lic. (See Obtain a
License Through autodesk.com on page 100.)

To configure automatic start-up of your license server

1 Locate your network license file and rename it adsk_server.lic.

2 Copy adsk_server.lic to the following directory: /var/flexlm/

NOTE Create this directory if it does not already exist.

3 Reboot your computer.

4 Use the Console to verify that lmgrd and adskflex start up successfully.

Configure a License Server (Linux)
You configure a license server so that you can manage your Autodesk product
licenses.

To configure automatic start-up of your license server

Before configuring your license server for Linux, ensure that the following
steps have been completed:

■ You have installed the Autodesk Network License Manager which contains
the following files: lmgrd, adskflex, and lmutil.

■ You have received the network license file from Autodesk that contains
the product licenses; for example, productlicense.lic.

1 Extract the FLEXnet IPv4 server files into the following directory:
/home/<user id>/flexlm11.7.

NOTE Replace <user id> with your user id, not a root user id.

104 | Chapter 5   Network Licensing Guide



2 Copy the .lic file into the flexlm11.7 directory created in Step 1.

3 Open a terminal window in root mode.

4 Go to the directory /etc/.

5 Locate the rc.local file.

6 Edit the rc.local file and start lmgrd by entering the following commands
in the terminal window:

NOTE Replace acad.lic with your license file name.

7 /bin/su <user id> -c ‘echo starting lmgrd>\

/home/<user id>/flexlm11.7/boot.log’

/usr/bin/nohup/bin/su <user id> -c ‘umask 022;\

/home/<user id>/flexlm11.7/lmgrd -c\

/home/<user id>/flexlm11.7/acad.lic >> \

/home/<user id>/flexlm11.7/boot.log ‘

/bin/su <user id> -c ‘echo sleep 5 >> \

/home/<user id>/flexlm11.7/boot.log ‘

/bin/sleep 5

/bin/su <user id> -c ‘echo lmdiag >>\

/home/<user id>/flexlm11.7/boot.log ‘

/bin/su <user id> -c ‘/home/<user id>/flexlm11.7/lmutil lmdiag

-n -c\

/home/<user id>/flexlm11.7/acad.lic >> \

/home/<user id>/flexlm11.7/boot.log ‘

/bin/su <user id> -c ‘echo exiting >>\

/home/<user id>/flexlm11.7/boot.log ‘

8 Save the edited rc.local file.

9 Reboot your machine and verify that the lmgrd and adskflex have started
by doing one of the following:

■ During the reboot, look for the message that the license server has
started.

■ Check the boot.log file created in /home/<user id>/flexlm11.7/ to see if
lmgrd and adskflex have started.
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NOTE Before performing any system maintenance on your license server, see Stop
and Restart the License Server on page 109.

Install SAMreport-Lite (Optional)
SAMreport-Lite is a reporting tool that helps you track network license usage.
With SAMreport-Lite technology from Acresso™ Software, you can monitor
client usage for Autodesk network licensed products.

To learn more about installing and using SAMreport-Lite, see the SAMreport-Lite
User’s Guide.

Uninstall the Network License Manager
You can uninstall the Network License Manager from the license server. When
you uninstall the Network License Manager, licenses are no longer available
to your users.

NOTE You must manually delete files that you created for use with the Network
License Manager (such as log files, license files, and the Options file). They are not
automatically deleted when you uninstall.

Uninstall the Network License Manager (Windows)

To uninstall the Network License Manager

1 Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

2 In the LMTOOLS program, click the Start/Stop/Reread tab.

3 On the Start/Stop/Reread tab, click Stop Server.

4 Close lmtools.exe.

5 In the Windows Control Panel, do one of the following:

■ (Windows XP) Double-click Add/Remove Programs.

■ (Windows 7/Windows Vista) Double-click Programs and Features.

106 | Chapter 5   Network Licensing Guide



Do one of the following:

■ (Windows XP) In the Add/Remove Programs window, click Autodesk
Network License Manager. Click Remove.

■ (Windows 7/Windows Vista) In the Programs and Features window,
click Autodesk Network License Manager. Click Remove.

6 If prompted, restart your computer.

Uninstall the Network License Manager (Mac OS X)

To uninstall the Network License Manager

1 Delete the following directories:

■ /usr/local/flexnetserver/

■ /Library/StartUpItems/adsknlm

This removes the main license server tools as well as the configuration
scripts that help you set up your license server.

2 Reboot your machine.

Uninstall the Network License Manager (Linux)

To uninstall the Network License Manager

1 Open a shell as a super user.

2 Execute the following command to verify the package number of the
Network License Manager that you installed:

rpm -qa |grep adlm

3 Execute the following command to uninstall the Network License Manager
package:

rpm -e adlmflexnetserver-#.rpm

where # is the package number.

4 If you edited your rc.local file to configure your license server (for example
to start lmgrd), remove those commands from the rc.local file.

(See also Configure a License Server (Linux) on page 104.)
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Network License Tools
Autodesk Network licensing tools include FLEXnet configuration tools, license
borrowing, and SAMreport-Lite. Each tool is described in the sections that
follow.

This section also includes information for updating FLEXnet and installing
and configuring the Autodesk Network License Manager on a network.

FLEXnet Configuration Tools
The Network License Manager uses FLEXnet® license management technology
from Acresso Software. FLEXnet provides administrative tools that help to
simplify management of network licenses. You can use FLEXnet tools to
monitor network license status, reset licenses lost to a system failure,
troubleshoot license servers, and update existing license files on the fly.

For specific information about using FLEXnet configuration tools, you can
find the LicenseAdministration.pdf document in the following directory:

■ (Windows) C:\Program Files\Autodesk Network License

Manager\Docs\FlexUser\LicenseAdministration.pdf

■ (Mac OS X) /usr/local/flexnetserver/LicenseAdministration.pdf

■ (Linux) /opt/flexnetserver/LicenseAdministration.pdf

Utilities for License Server Management
FLEXnet provides two utilities for managing the license server. These tools
are located in the C:\Program Files\Autodesk Network License Manager folder.

lmtools.exe Provides a Microsoft® Windows graphical user interface for
managing the license server.

lmutil.exe Provides a set of command line options for managing the license
server.

You can use lmtools.exe or lmutil.exe to perform the following server
management tasks:

■ Start, stop, and restart the server.

■ Configure, update, and reread the license file.
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■ Diagnose system or license problems.

■ View server status, including active license status.

Stop and Restart the License Server
Before you can perform any system maintenance on your license server, you
must stop the license server. When you have completed maintenance, you
can restart the license server.

To stop the license server (Windows)

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

1 Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

2 In the LMTOOLS program, on the Service/License File tab, select the
Configure Using Services option.

3 Select the service name for the license server you want to stop manually.

4 Click the Start/Stop/Reread tab.

5 On the Start/Stop/Reread tab, click Stop Server.

6 Close lmtools.exe.

To restart the license server (Windows)

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

1 Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

2 In the LMTOOLS program, on the Service/License File tab, select the
Configure Using Services option.

3 Select the service name for the license server you want to start manually.

4 Click the Start/Stop/Reread tab.

5 On the Start/Stop/Reread tab, click Start Server to restart the license server.
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To stop the license server (Mac OS X)

Enter the following in Terminal:

sudo /sbin/SystemStarter stop adsknlm

To restart the license server (Mac OS X)

Enter the following in Terminal:

sudo /sbin/SystemStarter restart adsknlm

To stop the license server (Linux)

Enter the following in Terminal:

./lmutil lmdown -q -force

To restart the license server (Linux)

Enter the following in Terminal:

./lmgrd -c acad.lic -l debug.log

NOTE Replace acad.lic with your license file name and debug.log with your log
file name.

Update FLEXnet from a Previous Version
This release of Autodesk products and later require FLEXnet version 11.7.0.0
or later. If you are currently using a version of FLEXnet that is earlier than
11.7.0.0, you need to upgrade to version 11.7.0.0 or later.

NOTE If the server where you plan to install the Autodesk Network License
Manager has FLEXnet installed for another product, make sure that the version of
lmgrd.exe is the most current version.

To determine what version of FLEXnet is installed, you need to verify the
version of the following files:

Windows

■ lmgrd.exe

■ lmtools.exe

■ lmutil.exe
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■ adskflex.exe

Mac OS X or Linux

■ lmgrd

■ lmutil

■ adskflex

To verify the version of lmutil.exe, lmtools.exe, or adskflex.exe (Windows)

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

1 Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

2 In lmtools.exe, click the Utilities tab.

3 On the Utilities tab, enter the location of the file, or click the Browse
button to locate the file and click Open. The file location should look
something like this:

C:\Program Files\Autodesk Network License Manager\lmutil.exe

4 On the Utilities tab, click Find Version.

The version number of the file you selected is displayed. If necessary, use
the following procedure to update your version of FLEXnet.

To verify the version of lmutil, lmgrd, or adskflex (Mac OS X or Linux)

You should be logged in with the same user ID you used when installing the
FLEXnet files, for example, /Users/<userid>/adsknlm (Mac OS X) or
/home/<userid>/adsknlm (Linux).

Enter the following commands in the terminal window/prompt:

<prompt>./lmutil -v

<prompt>./lmgrd -v

<prompt>./adskflex -v

The output of each command will look similar to this example:

Copyright © 1989-2007 Macrovision Europe Ltd. And/or Macrovision

Corporation. All Rights reserved.

lmutil v11.5.0.0 build 56285 i86_mac10
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To update FLEXnet (Windows)

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

1 Back up your license files.

2 Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

3 In the LMTOOLS program, click the Start/Stop/Reread tab.

4 On the Start/Stop/Reread tab, click Stop Server.

5 Close lmtools.exe.

6 Note the location where the Network License Manager is installed and
then uninstall the Network License Manager. For details about uninstalling
the Network License Manager, see Uninstall the Network License Manager.

7 Install the Network License Manager. For details about installing the
Network License Manager to the same location as the previous version,
see Install the Network License Manager.

8 Do one of the following:

■ (Windows XP) Click Start  ➤  Programs  ➤  Autodesk  ➤  Network
License Manager  ➤  LMTOOLS.

■ (Windows Vista) Double-click the LMTOOLS icon on the desktop.

9 In the LMTOOLS program, click the Start/Stop/Reread tab.

10 On the Start/Stop/Reread tab, click Start Server.

11 Close lmtools.exe.

To update FLEXnet (Mac OS X)

You should be logged in with the same user ID you used when installing the
FLEXnet files, for example, /Users/<userid>/adsknlm. The logged in user ID
should be in the sudoers list to execute some of the following commands.

1 Back up your license files.

2 Stop the Autodesk Network License Manager service by entering the
following in Terminal:

sudo /sbin/SystemStarter stop adsknlm
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3 Note the location where the Network License Manager is installed and
then uninstall the Network License Manager by entering the standard
Mac OS X commands, for example, rm.

4 Install the Network License Manager. Copy the new version of the
FLEXnet network license manager files (lmgrd, adskflex, and lmutil) to
the location recommended when you configured your license server, for
example, /Users/<user id>/adsknlm.

5 Start the Autodesk Network License Manager service by entering the
following in Terminal:

sudo /sbin/SystemStarter start adsknlm

NOTE Version 11.7.0.0 of the FLEXnet license manager that ships with Autodesk
products is backwards compatible and will administer licenses for the Autodesk
2008-, 2007-, 2006-, 2005-, 2004-, and 2002-based products.

To update FLEXnet (Linux)

You should be logged in with the same user ID you used when installing the
FLEXnet files, for example, /home/<userid>/adsknlm. The logged in user ID
should be in the sudoers list to execute some of the following commands.

1 Back up your license files.

2 Stop the Autodesk Network License Manager service by entering the
following in Terminal:

./lmutil lmdown -q -force

3 Note the location where the Network License Manager is installed and
then uninstall the Network License Manager by entering the standard
Linux commands, for example, rm.

4 Install the Network License Manager. Copy the new version of the
FLEXnet network license manager files (lmgrd, adskflex, and lmutil) to
the location recommended when you configured your license server, for
example, /home/<user id>/adsknlm.

5 Start the Autodesk Network License Manager service by entering the
following in Terminal:

./lmgrd -c acad.lic -l debug.log

NOTE Replace acad.lic and debug.log with your license file name and log file
name.
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NOTE Version 11.7.0.0 of the FLEXnet license manager that ships with Autodesk
products is backwards compatible and will administer licenses for the Autodesk
2008-, 2007-, 2006-, 2005-, 2004-, and 2002-based products.

Set Up and Use an Options File
With an Options file, you set configuration options for managing licenses on
each license server that you set up. An Options file sets parameters that the
license file reads and the lmgrd program executes.

If you want to have the same license behavior on some or all of your license
servers, you must save the same Options file to each of those license servers.
If you want to specify different license behavior on different license servers,
you must create an Options file for each license behavior. You must save each
Options file to the server where you want specific license behavior.

NOTE For Options file changes to take effect on a license server, you must save
the Options file, and then use lmtools.exe to reread the license file.

Use the Options file to set parameters for the following server-related features:

Report log file A compressed, encrypted file is created that generates accurate
usage reports on license activity for use by SAMreport-Lite. See Create a Report
Log on page 116.

License borrowing If your Autodesk product supports the license borrowing
feature, you can allow users to borrow an Autodesk product license from a
network license server so that they can use the product without being
connected to the license server. A license can be borrowed for a limited time.
See Configure License Borrowing with the Options File on page 116.

License timeout With license timeout, you can set a timeout period on your
license server for one Autodesk product at a time. When set, license timeout
returns a license to the license server when a connection with the workstation
is lost, or if a license is checked out but the Autodesk product is idle on a
workstation for longer than the timeout period you define. See Set Up License
Timeout on page 117.

License timeoutall With license timeoutall, you can set a timeout period on
your license server that applies to all Autodesk products installed on your
computer. When set, license timeout returns a license to the license server
when a connection with the workstation is lost, or if a license is checked out
but the Autodesk product is idle on a workstation for longer than the timeout
period you define. See Set Up License Timeout on page 117.
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Here is an example of the contents of an Options file:

REPORTLOG=c:\test\report.rl

BORROW_LOWWATER Autodesk_f1 3

TIMEOUT Autodesk_f1 7200

You can also set up advanced license parameters, such as reserving a license,
restricting license usage, or defining groups of users. To learn more about
setting advanced Options file parameters, see the FLEXnet documentation in
the C:\Program Files\Autodesk Network License Manager\LicenseAdministration.pdf
file.

Create an Options file
You should be logged in with Administrator rights when working with the
LMTOOLS utility.

To create an options file

1 Open a text editor, enter the parameters you want, and then save the
document as a file named adskflex.opt to the same location where you
saved the license file.

NOTE Make sure you save the file with the extension .opt. The default
extension .txt is not recognized by the Network License Manager.

2 Do one of the following:

■ (Windows) Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network
License Manager  ➤  LMTOOLS Utility.

■ (Mac OS X) Launch a Terminal window, navigate to the Autodesk
Network License Manager folder, and enter the following:
./lmutil lmreread -c @hostname-all

Close the Terminal window.

3 In the LMTOOLS program, on the Start/Stop/Reread tab.

4 On the Start/Stop/Reread tab, click ReRead License File.

5 Close lmtools.exe.
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Create a Report Log
In the Options file, you can create a report log file that is used with
SAMreport-Lite.

To create a report log

1 In a text editor, open the Options file, adskflex.opt.

2 In the Options file, enter the following syntax on its own line (with
REPORTLOG entered in uppercase, as shown):

REPORTLOG [+]report_log_path

For example (Windows), the syntax REPORTLOG +"c:\My
Documents\report.rl" means that a report log named report.rl is located
in the folder c:\My Documents.

For example (Mac OS X or Linux), the syntax REPORTLOG +"/Users/<user
id>/NLM/report.rl" means that a report log named report.rl is located in
the folder /Users/<user id>/NLM.

NOTE Path names that contain spaces must be enclosed in quotation marks.

In the REPORTLOG syntax, “[+]” means that entries to the log file you
create are appended rather than replaced each time the Network License
Manager is restarted. (It is recommended that you use this option so that
you retain a history of log entries.)

Configure License Borrowing with the Options File
If your Autodesk product supports the license borrowing feature, you can use
the Options file to configure license borrowing options. For example, you can
define the maximum number of licenses that cannot be borrowed from your
network at any one time. In addition, you can define which users can borrow
an Autodesk product license. Licenses are borrowed per user, not per machine.

NOTE If your Autodesk product supports license borrowing, and licenses are
borrowed from a redundant license server pool, you must restart the license server
after you stop the Network License Manager.

At the end of a borrow period, the borrowed license is automatically disabled
on the user's computer and becomes available again on the license server.
Users can also return a license before a borrow period has ended.
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To set license borrowing parameters

1 In the Options file, enter the following syntax on its own line (with
BORROW_LOWWATER entered in uppercase, as shown):

BORROW_LOWWATER feature_code n

In the BORROW syntax, “feature_code” is the name of the product in
the license file, and “n” is the number of licenses that cannot be borrowed.

For example, the syntax BORROW_LOWWATER Autodesk_f1 3 means
that for the product Autodesk_f1, three licenses cannot be borrowed from
the license server.

2 Enter the following syntax on the next line (with MAX_BORROW_HOURS
entered in uppercase, as shown):

MAX_BORROW_HOURS feature_code n

In this syntax, “n” is the number of hours that a license can be borrowed.

For example, the syntax MAX_BORROW_HOURS Autodesk_f1 360 means
that for product Autodesk_f1, licenses can be borrowed for 360 hours, or
15 days.

NOTE Licenses are borrowed in increments of 24 hours only. Any number
that is more than a 24-hour increment is not used. For example, the number
365 would be rounded down to 360 hours, or 15 days.

For more information about setting up the license borrowing feature, see the
FLEXnet documentation in the C:\Program Files\Autodesk Network License
Manager folder.

NOTE To borrow a license in an Autodesk product, click Help menu  ➤  About
 ➤  Product Information. Alternatively, enter borrowlicense on the product
command line. Help for this feature is available in the Borrow a License for [Autodesk
Product] window and in C:\Program Files\[Autodesk Product]\Help\adsk_brw.chm.

Set Up License Timeout
License timeout is set in the Options file to determine how long a product
session can be idle before the license is reclaimed by the license server. When
you set this flag in the Options file, a user's license is reclaimed by the license
server if the product is idle on a workstation for more than the timeout period
you define.
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If a user's license is lost because of the idle timeout, the product attempts to
claim a new license once the user uses the product again. If no license is
available, the user can save work before the product shuts down.

You can set individual license timeouts for each Autodesk product on your
computer by using the TIMEOUT parameter or you can set one license timeout
for all Autodesk products on your computer by using the TIMEOUTALL
parameter.

To set license timeout parameters

■ For individual Autodesk products: In the Options file, enter the following
syntax on its own line (with TIMEOUT entered in uppercase, as shown):
TIMEOUT feature_code n

In the TIMEOUT syntax, “feature_code” is the name of the product (referred
to in the INCREMENT line in the license file), and “n” is the number of
seconds before an inactive license is reclaimed by the license server.

For example, the syntax TIMEOUT Autodesk_f1 7200 means that for the
product Autodesk_f1, the license timeout period is set for 7200 seconds,
or two hours.

■ For all Autodesk products: In the Options file, enter the following syntax
on its own line (with TIMEOUTALL entered in uppercase, as shown):
TIMEOUTALL n

In the TIMEOUTALL syntax, “n” is the number of seconds before an
inactive license is reclaimed by the license server.

For example, the syntax TIMEOUTALL 7200 means that for all Autodesk
products, the license timeout period is set for 7200 seconds, or two hours.

For more information about using the license timeout feature, see the FLEXnet
documentation in the C:\Program Files\Autodesk Network License Manager
folder.

License Borrowing
If you are running a network-licensed version of the program, you can borrow
a license from a license server to use the program for a specified time when
your computer is not connected to the network.
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Overview
If you are using a network-licensed version of your Autodesk product and your
network administrator supports the license borrowing feature, you can borrow
a product license from your network license server to use the program when
your computer is not connected to the network. Your license is automatically
returned to the license server at the end of the day on the return date you set
when you borrowed the license. You can also return a license early.

NOTE There is a limit to the number of licenses available for borrowing. If you try
to borrow a license and are notified that no licenses are available, all network
licenses may already be borrowed by other users. If you are unable to borrow a
license, see your network administrator for help.

If you have a stand-alone version of the program, you cannot borrow a license.
You can, however, use the License Transfer Utility to transfer your license
from one computer to another. To check your license type, select Help > About
Maya from the main menu bar and click Product License Information to open
the dialog box.

Important notes on borrowing Maya licenses

Borrowing a Maya license using the general Autodesk license borrowing
procedure does not borrow licenses for specialized nodes such as mental ray
batch render nodes or fluid simulation nodes. If you are borrowing a Maya
license and plan to use mental ray or fluid simulation while you have a
borrowed license, use the Maya-specific license borrowing steps. See Borrow
a Maya license with sub-features on page 121.

Borrow a License
You can run the program when your computer is not connected to the network
until your license-borrowing period ends. If you don't remember the date that
a license expires, you can check the date by selecting Help > About Maya and
clicking Product License Information. This opens the Product License
Information dialog box.

When the license-borrowing period expires, the borrowed license is
automatically returned to the license server. Once your computer is
reconnected to the network, you can run the program from the network or
borrow a license again.
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Interaction with Other License-Borrowing Tools

Using the license borrowing feature in the program is the recommended way
to borrow a license; however, some third-party borrowing tools may also be
available to you. These tools are not supported or compatible with the license
borrowing feature in the program. Other third-party or legacy
license-borrowing tools that may be available to you are the Autodesk License
Borrowing utility (shipped with Autodesk products) and the borrowing feature
in lmtools.exe, a component of the Autodesk Network License Manager.

If another license-borrowing tool is active when you attempt to use the license
borrowing feature, you should proceed as follows to borrow a license for the
program:

■ If you run the Autodesk License Borrowing utility that shipped with your
Autodesk product and then turn on the borrowing flag for the Adskflex
option or the All option, a license can be borrowed when you start the
program. However, you cannot return a license until you exit and then
restart the program.

■ If borrowing is set in lmtools.exe for all products, you can either (a) use the
other tool to borrow licenses for the program or (b) stop the borrowing
process in lmtools.exe and then use the license borrowing feature in the
program.

■ If borrowing is set in lmtools.exe for non-Autodesk products only, you must
stop the borrowing process in lmtools.exe. You can then use the license
borrowing feature to borrow licenses for your Autodesk product. If you do
not stop the borrowing process in lmtools.exe, the license borrowing feature
will not function.

To borrow a license using the Help menu

1 Select Help > About Maya.

2 In the About Maya window, click Product License Information.

3 In the Product License Information window, click Borrow License.

4 In the Borrow a License window, on the calendar, click the date when
you want to return the license.

This date must be within the valid date range set by your network
administrator. The valid date range is displayed in this window.

5 Click Borrow License.

6 In the License Borrowed message, click OK.
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The license is borrowed, and you can now use the program while your
computer is disconnected from the network.

Borrow a License window
Using the license borrowing feature, you can borrow a license from your
network license server, and then use the license when your computer is
disconnected from the license server; for example, when you are traveling for
work.

The Borrow a License window has the following options:

Calendar Sets the date when you plan to return a borrowed license. The return
date must be within the range specified by your network administrator.

Borrow a License Borrows the license from the network license server based
on the return date that you specified.

Cancel Cancels the borrowing action; no license is borrowed.

Borrow a Maya license with sub-features
If you are planning to borrow a license and you need to use the mental ray
batch render nodes or fluid simulation while you have the license borrowed,
use the following steps to borrow a license.

Borrow a Maya license

To borrow a Maya license (Windows)

NOTE The LMTOOLS utility is packaged with the Network License Manager. If
you do not have the LMTOOLS utility installed, you can install it as part of the the
Network License Manager. See Install the Network License Manager on page 98.

1 Open the LMTOOLS utility by selecting Start > Programs > Autodesk >
Common Utilities > FlexLM License Utilities.

2 In the LMTOOLS utility, switch to the Borrowing tab.

3 In the Vendor Name field, enter adskflex.

4 Enter the Return Date and the Return Time, then click Set Borrow
Expiration.

License Borrowing | 121



5 Launch Maya.

This borrows a Maya license from the server.

6 Use any sub-features of Maya (such as fluid simulation, mental ray
rendering, or the mental ray local batch render) while you are still
connected to your license server. This automatically borrows a license
for those sub-features.

After you have used the sub-feature(s) while connected to your license
server, you can then use the sub-features later when you are not
connected.

To borrow a Maya license (Mac OS X or Linux)

1 Open a shell (Linux) or Terminal (Mac OS X) window.

2 Execute the following command: lmutil lmborrow adskflex enddate

[time]

where enddate is the date you will return the license, formatted as follows:
dd-mmm-yyyy. The time argument is optional, but is specified in 24-hour
format (hh:mm).

For example: lmutil lmborrow adskflex 14-oct-2010 [14:00] borrows
a license until October 14, 2010 at 2:00 pm.

3 Launch Maya.

This borrows a Maya license from the server.

4 Use any sub-features of Maya (such as fluid simulation, mental ray
rendering, or the mental ray local batch render) while you are still
connected to your license server. This automatically borrows a license
for those sub-features.

After you have used the sub-feature(s) while connected to your license
server, you can then use the sub-features later when you are not
connected.

Stop borrowing a Maya license

Stopping license borrowing is different from returning a license. You can stop
borrowing licenses if you have already checked out all of the licenses you
want, but you still plan to use sub-features while you are connected to the
network server and do not want to borrow those licenses.

For example, you can borrow a Maya license and a mental ray subfeature
license, then stop borrowing so that when you use fluid simulation (and
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automatically use a subfeature license for fluid simulation), you do not borrow
the fluid simulation license from the server. In this situation, after you stop
borrowing, your Maya and mental ray licenses are still borrowed until the
return date that you set, but the fluid simulation license you used stays on
the server.

To stop borrowing a Maya license (Windows)

1 Open the LMTOOLS utility by selecting Start > Programs > Autodesk >
Common Utilities > FlexLM License Utilities.

2 In the LMTOOLS utility, switch to the Borrowing tab.

3 Click Don’t Borrow Anymore Today.

To stop borrowing a Maya license (Mac OS X or Linux)

1 Open a shell (Linux) or Terminal (Mac OS X) window.

2 Execute the following command: lmutil lmborrow -clear

Return a Maya license and sub-feature licenses

Your network license is automatically returned to the network license server
at the end of the return date you set when you borrowed the license. You can
also return a license earlier than the date you originally selected, as long as
your computer is connected to the network license server when you attempt
to return the borrowed license.

Returning a license means that you are returning a license to the network
server so that someone else can use or borrow it. Once a borrowed license is
returned, you can borrow a license again as long as your computer is connected
to the network license server and a license is available on the server.

If you use fluid simulation, mental ray rendering, or the mental ray local batch
render features while you have a Maya license borrowed from your license
server, you have automatically borrowed a sub-feature license. The following
steps include information on properly returning the licenses for those
sub-features. The following table lists the feature codes that you will need if
you use these sub-features.

Feature license codeFeature or Sub-feature

85537MAYA_2011_0FMaya

85537MAYAMFS_2011_0FFluid simulation
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Feature license codeFeature or Sub-feature

85537MAYAMMR_2011_0Fmental ray interactive

85537MAYAMMR1_2011_0Fmental ray local batch render nodes
85537MAYAMMR2_2011_0F
85537MAYAMMR3_2011_0F
85537MAYAMMR4_2011_0F
85537MAYAMMR5_2011_0F

To return a license early (Windows)

1 Open the LMTOOLS utility by selecting Start > Programs > Autodesk >
Common Utilities > FlexLM License Utilities.

2 In the LMTOOLS utility, switch to the Borrowing tab.

3 Click List Currently Borrowed Features, and note any sub-features that
are listed in the bottom pane of the Borrowing tab.

For example, if you have used fluid simulation, the sub-feature code
85537MAYAMFS_2011_0F is listed.

4 (Optional) If you are returning sub-feature licenses, copy the sub-feature
code and paste it into the Feature Name field.

5 Click Return Borrowed Licenses Early.

6 Repeat steps 4 and 5 for all sub-features you have borrowed.

To return a license early (Mac OS X or Linux)

On the same computer where you borrowed the license, do the following:

1 Open a shell (Linux) or Terminal (Mac OS X) window.

2 Execute the following command to determine if you have borrowed any
sub-feature licenses: lmutil lmborrow -status

The command returns the feature codes for any sub-feature licenses you
have checked out. For example, if you have used mental ray rendering,
the feature code 85537MAYAMMR_2011_0F displays.

3 Execute the following command: lmutil lmborrow -return <feature>

where <feature> specifies the code of the feature or subfeature for which
you are returning a license.
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Return a license
Your network license is automatically returned to the network license server
on the day that the license expires. You can also return a license earlier than
the date you originally selected, as long as your computer is connected to the
network license server when you attempt to return the borrowed license.

Once a borrowed license is returned, you can borrow a license again as long
as your computer is connected to the network license server and a license is
available on the server.

To return a borrowed license early

1 Select Help > About Maya, then click Product License Information.

2 In the Product License Information window, click Return License, then
click Yes.

Your license is returned to the network license server. After you return
the borrowed license, you can borrow a license again immediately as long
as a license for that product is available on the network.

To check the license return date

1 Select Help > About Maya, then click Product License Information.

2 In the Product License Information window, under License Expiration
Date, view the license return date.

Network Licensing FAQs

What is the difference between a stand-alone license and a
network license?

Stand-alone licensed products are registered and activated to an individual
workstation. While the software can be installed on multiple systems in your
facility, the license only allows one system to be operational. If you need to
run more systems, you need to purchase more stand-alone licensed products,
or consider converting to network licenses.

Network licensed products rely on the Network License Manager to keep track
of software licenses. The software can be installed and run on multiple systems,
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up to the maximum number of licenses you’ve purchased. The Network License
Manager “checks out” licenses until they are all in use. No further systems
can run the program until a license is “checked in.” If you need to run more
systems, you can purchase additional licenses for the Network License Manager
to maintain.

What is the benefit of using a network licensed version of the
software?

Network licensed products are recommended for large drafting/design facilities,
classrooms, and lab environments. The main advantage is that you can install
products on more systems than the number of licenses you have purchased
(for example, purchasing 25 licenses but installing on 40 workstations). At
any one time, products will run on the maximum number of systems for
which you have licenses. This means you get a true floating license. If software
needs to be run on more systems, additional licenses can be purchased.

Registration and activation occurs only once and the licenses are maintained
on your network license server.

How do I switch my license from stand-alone to network or
network to stand-alone?

If you have purchased stand-alone and network licenses and you want to
switch which license Maya is using, there are two main methods to change
the license type.

■ Uninstall and re-install Maya, changing the type of license you specify
during the install.

■ Edit the MAYA_LICENSE_METHOD environment variable in your
license.env file.
If you have added the MAYA_LICENSE_METHOD variable to your system
environment variables or to a Maya.env file, you must also update the
license type in those locations.

To edit the MAYA_LICENSE_METHOD environment variable

1 Locate the license.env file in the following location:

■ (Windows) C:\Program Files\Autodesk\Maya2011\bin
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■ (Linux) /usr/autodesk/maya2011-x64/bin

■ (Mac OS X) In the Maya installation directory (by default
/Applications/Autodesk/maya2011/), right-click the Maya application
and select Show Package Contents. Locate the license.env file in the
Contents directory.

2 Edit the MAYA_LICENSE_METHOD variable to indicate the type of license
you want, for example:

MAYA_LICENSE_METHOD=standalone

to set Maya to use a stand-alone license, or

MAYA_LICENSE_METHOD=network

to set Maya to use a network license.

If you are switching from a stand-alone to a network license, continue
with the following steps to set your license server name.

3 Navigate to the following directory to locate and open the LICPATH.LIC
file.

■ (Windows) C:\Program Files\Autodesk\Maya2011

■ (Mac OS X and Linux) /var/flexlm/

4 Edit the line SERVER <servername> where <servername> is your license
server name.

If you do not find the LICPATH.LIC file in this location, you can create a
license file by saving a text file with the extension .lic, and including the
following lines:

SERVER <servername> 0

USE_SERVER

IMPORTANT If you have added the MAYA_LICENSE_METHOD variable to your
system environment variables or to a Maya.env file, you must also update the
license type in those locations.

To locate the Maya.env file

■ (Windows) C:\Documents and Settings\user\My Documents\maya

■ (Mac OS X)
/Users/username/Library/Preferences/Autodesk/maya/version
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■ (Linux) /home/<user>/maya

How do I change the license server information I entered during
the installation?

To change the license server information you entered

1 Navigate to the following directory to locate and open the LICPATH.LIC
file.

■ (Windows) C:\Program Files\Autodesk\Maya2011

■ (Mac OS X and Linux) /var/flexlm/

2 Edit the line SERVER <servername> where <servername> is your license
server name.

If you do not find the LICPATH.LIC file in this location, you can create a
license file by saving a text file with the extension .lic, and including the
following lines:

SERVER <servername> 0

USE_SERVER

What is Internet Explorer used for?
After installing your product, you can operate in trial mode for a given number
of days. Whenever you launch the program, you are prompted to activate the
software. When you choose to activate the software, Internet Explorer makes
this process much faster. Once you entered your registration data and submit
it to Autodesk, an activation code is returned and you are not prompted again
during startup.

Where can I find more information on troubleshooting network
licensing?

If you experience difficulty with installation or licensing, visit
http://autodesk.com/servicesandsupport for additional FAQ information, as well
as an in-depth Knowledge Base that you can search for solutions to common
installation and licensing issues and error messages.
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Glossary of Licensing
Terms

ADSKFLEX_LICENSE_FILE In a distributed license server configuration, the environment
variable used to point a workstation to the distributed license servers.

adskflex.exe The Autodesk vendor daemon used with the FLEXnet license technology. This
daemon keeps track of the Autodesk licenses that are checked out and the workstations that
are using the licenses.

borrowed license A license that allows you to use an Autodesk product for a limited period
of time without having to buy a separate license or have network access to the license server.

daemon A program that runs continuously in the background of a computer. The daemon
handles requests from the computer and then forwards the requests to other programs or
processes. The Network License Manager uses two daemons: the vendor daemon (adskflex.exe)
and the license manager daemon (lmgrd.exe).

debug log file A file used with FLEXnet to log connection activity (such as license failure or
starting and stopping) between the Network License Manager and the workstation.

deployment The files and folders created on a server and used by workstations to install
Autodesk programs.

distributed server A license server configuration option in which several servers are used to
manage license distribution. Each distributed license server has a unique license file and a
fixed number of licenses. If one distributed license server fails, the other servers are still able
to distribute their licenses.

Ethernet address See host ID.

feature code A license file parameter that represents the product that is supported by that
license file.

6

129



FLEXnet The Acresso Software license management technology implemented in the Autodesk
family of products.

heartbeat signal The communication signal between the Network License Manager and
the workstation to verify that the workstation is accessible and has an active Autodesk
product session running.

host ID The unique hardware address of a network adapter. Also known as Ethernet address
or physical address.

host name The TCP/IP name associated with a computer. FLEXnet technology uses the
host name as a parameter; the host name must be distinguished from the NetBIOS (server)
name.

idle A state of inactivity in your product that prompts a network license server to reclaim
a license. Inactivity is due to no mouse or keyboard activity and no commands, LISP
expressions, menu macros, or scripts in progress for the period of time that is defined in
the Options file. See also license timeout.

JRE (Java Runtime Environment) A program that is required to run Java programs. This
program must be installed with SAMreport-Lite.

license file A file used with FLEXnet that controls the number of available seats. This file
must be in ASCII plain text format.

license server A server that contains the Network License Manager.

license timeout A feature that allows you to set up a timeout period on your license server
to automatically return an idle license to the server so that it is available for use again.

licpath.lic In both single and redundant server configurations, the file used to point the
workstation to the FLEXnet license server. Licpath.lic is located in the root installation folder.

lmgrd.exe The license manager daemon. This daemon handles the original contact with the
program, and then passes the connection to the vendor daemon, adskflex.exe.

lmtools.exe A graphical user interface utility used to administer the FLEXnet license
technology. (Lmutil.exe is the command line version of this utility.)

lmutil.exe A command line utility used to administer the FLEXnet license technology.
(Lmtools.exe is the graphical user interface version of this utility.)

master daemon See lmgrd.exe.

network license installation A type of installation that requires you to install and run the
Network License Manager from a network server. You must install and configure the Network
License Manager before clients can run the Autodesk product.
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Network License Manager The technology used by Autodesk for network license
management.

Options file The file used by FLEXnet to control license manager parameters, such as
reserving licenses and creating report logs used with SAMreport-Lite.

physical address See host ID.

redundant server A license server configuration option in which three servers are used to
administer licenses. The redundant servers share a license file and a pool of licenses. The
redundant server pool remains functional as long as two of the three servers are running
and communicating with each other.

report log file A file used with FLEXnet and SAMreport-Lite. This log file provides
information about network license usage. The Options file creates the report log.

SAMreport-Lite A version of Acresso Software's SAMreport tool. SAMreport-Lite is included
on the Autodesk product discs.

vendor daemon See adskflex.exe.

workstation A desktop computer used by an individual user on a network.
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